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Glossary

aBSD

Annular Backscattered Electron Detector

AIC

Ampere Interrupting Capacity

Aperture

Mechanical limitation of an opening ori-
ented perpendicular to the optical axis,
which filters out electrons whose trajec-
tories (tracks) do not run close to the op-
tical axis.

aSTEM

Annular Scanning Transmission Electron
Microscopy

Astigmatism

Lens aberration that distorts the shape of
the electron beam, compensated by the
stigmator.

Backscattered electrons

High-energy electrons that are liberated
from the specimen surface when the
specimen is hit by the primary electron
beam.

Bakeout

Degassing of surfaces of a vacuum sys-
tem by heating during the pumping
process.

Beam booster

Anode and liner tube of the Gemini col-
umn are connected mechanically and
electrically forming the beam booster. A
booster voltage (UB, liner voltage) of
+8 kV is applied to the beam booster, so
that a high beam energy is maintained
throughout the entire column. The beam
booster technique has two main advan-
tages: It minimizes beam widening, that
may occur due to stochastic electron-
electron interactions. Consequently there
is almost no loss in beam brightness,
even at low acceleration voltages. Sec-
ondly, the beam booster technique en-
hances protection against external stray
fields.

BSD

Backscattered Electron Detector

BSE

Backscattered Electron

CAN

Controller Area Network

CCD

Charge-Coupled Device

CL

Cathodoluminescence

Condenser

Device that collects and focuses the elec-
tron beam onto the specimen.

D

Depth

DECT

Digital Enhanced Cordless Telecommuni-
cations

EBSD

Electron Backscatter Diffraction

EC

European Community

EDS

Energy Dispersive X-ray Spectroscopy

EDX

Energy Dispersive X-ray Spectroscopy

EHT

Extra High Tension

EIGA

European Industrial Gases Association

EM

Electron Microscope

EM server

A server that implements the internal
communication between control soft-
ware and microscope hardware.
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EMC

Electromagnetic Compatibility

EMO

Emergency Off

EsB

Energy-selective Backscattered

Eucentric

Type of stage, the rotation axes of which
intersect in the same point. The specimen
surface is located in the eucentric point,
where the tilt axis meets the beam axis.
This guarantees that the focus is main-
tained when the specimen is tilted at a
certain working distance.

Extractor

Positive electrode that attracts electrons
from the filament.

Faraday cup

Small insulated metal container,
equipped with an aperture where elec-
trons can enter but not escape. Used to
measure the specimen current in the mi-
croscope.

FESEM

Field Emission Scanning Electron Micro-
scope

FIB

Focused Ion Beam

Focus wobble

Function that sweeps the focus of the
objective lens backwards and forward
through the focus on the specimen
plane. When the aperture is misaligned a
lateral shift is observed.

FTP

File Transfer Protocol

GIS

Gas Injection System

GUI

Graphical User Interface

H

Height

IGC

Industrial Gases Council

IGP

Ion Getter Pump

IR

Infrared

LOTO

Lockout/Tagout

M

M-axis

MSDS

Material Safety Data Sheet

PC

Personal Computer

PE

Protective Earth (ground)

PE

Primary Electron

Penning gauge

Device for measuring high vacuum in the
vacuum system.

Pre-vacuum pump

A pump for generating a pre-vacuum.

Primary electron beam

Narrowly bundled beam of accelerated
electrons that hit the specimen surface.

R

R-axis (Rotation)

RF

Radio Frequency

RMS

Root Mean Square

Schottky field emitter

Type of electron source in which emis-
sion occurs at or near the work function
barrier.
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Scintillator

Substance that absorbs electrons and in
response, fluoresces photons while re-
leasing the previously absorbed energy.

SE

Secondary Electron

Secondary electrons

Low-energy electrons that are emitted
from the specimen surface when the
specimen is hit by the primary electron
beam. Secondary electrons are generated
by inelastic scattering.

SEM

Scanning Electron Microscope

SEMI

Semiconductor Equipment and Materials
International (SEMI) is a industry associa-
tion comprising companies involved in
the electronics design and manufacturing
supply chain.

SESI

Secondary Electron Secondary Ion

SIMS

Secondary Ion Mass Spectrometry

STEM

Scanning Transmission Electron Micro-
scope

Stigmator

Compensates astigmatism (lens aberra-
tion), so that the electron beam becomes
rotationally symmetrical.

Suppressor

Electrode (anode) that suppresses un-
wanted thermionic emission from the
shank of the Schottky field emitter.

T

T-axis (Tilt)

TEM

Transmission Electron Microscope

U

Voltage

User

Person examining a sample under the mi-
croscope.

W

Width

WD

Working Distance

WDS

Wavelength Dispersive X-ray Spec-
troscopy

WDX

Wavelength Dispersive X-ray Spec-
troscopy

WEEE

Waste Electrical and Electronic Equip-
ment

X

X-axis

XeF₂ precursor

Xenon difluoride precursor

X-ray

Type of high energy electromagnetic ra-
diation, that is generated during the op-
eration of electron microscopes.

Y

Y-axis

Z

Z-axis

ZEISS Sales & Servicepartner

The sales and servicepartner is generally
in the field for customer support in a re-
gional area and / or a clearly defined cus-
tomer group.
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1 General Information
This manual is part of the SEM workstation, hereinafter referred to as the “microscope”. Read the
instructions carefully. Keep the manual nearby the microscope and hand it over to future owners
of the microscope.

The manual is designed for operators who have been trained to operate the microscope by a
ZEISS service representative. Basic operator training and safety instructions will be provided within
the scope of initial start-up by ZEISS. Operators of the microscope must not deviate from the in-
structions provided in this manual.

This manual contains the following chapters:

Chapter Content

Glossary Lists important technical terms.

General Information Explains the function and structure of this manual.

Safety Summarizes important safety details.

Device Description Describes the microscope and its main hardware components.

Software Description Provides an overview of the user interface.

Installation Refers to the ZEISS service representatives.

Operation Contains information about starting the microscope and the software,
obtaining a first image, adjusting important parameters, and power-
ing down the microscope, also in emergency.

Maintenance and
Repair

Informs you about preventive maintenance work and intervals and the
change of consumables.

Troubleshooting Describes common issues and how to resolve them.

Shutdown and Dis-
posal

Summarizes notes on shutdown and disposal.

Technical Data and
Conformity

Lists hardware specifications as well as the manufacturer’s declaration
that the equipment is in conformity with all applicable European Di-
rectives.

Parts and Tools Lists consumables, spare parts, tools, and accessories.

Abbreviations Lists abbreviations used in this manual.

Index Lists keywords to help you find relevant information quickly.

1.1 Text Conventions and Link Types

The following text conventions and link types are used:

Text convention Meaning

Click Start.

Press the STANDBY button.

Press [Enter] on the keyboard.

The names of controls and important infor-
mation are shown in bold letters.

Press <Ctrl+Alt+Del> Press several keys on the keyboard simultane-
ously.
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Text convention Meaning

Select Tools > Goto Control Panel > Air-
lock.

Follow a path in the software.

Text input

Text output

§ Text to be entered by the user

§ Text displayed by the system

Programming and Macros Anything typed in literally during program-
ming, including, for example, macro codes,
keywords, data types, method names, vari-
ables, class names, and interface names.

Tab. 1: Text convention

Link type Meaning

See: Text Conventions and Link Types [} 9]. Link to further information for this topic.

https://www.zeiss.com/corporate/int/
home.html

Link to a website on the internet.

Tab. 2: Link types

1.2 Explanation on Warnings and Additional Information

DANGER, WARNING, CAUTION, and NOTICE are standard signal words used to determine the lev-
els of hazards and risks of personal injury and property damage. Not only the safety instructions
and warnings in the Safety chapter are to be considered but also the safety instructions and
warnings in other chapters. Failure to comply with these instructions and warnings can result in
both personal injury and property damage and involve the loss of any claims for damages.

The following symbols and warnings indicating dangerous situations and hazards are used in this
document.

 DANGER

Type and source of danger
DANGER indicates an imminently hazardous situation which, if not avoided, will result in death
or serious injury.

 WARNING

Type and source of danger
WARNING indicates a potentially hazardous situation which, if not avoided, may result in
death or serious injury.

 CAUTION

Type and source of danger
CAUTION indicates a potentially hazardous situation which, if not avoided, may result in minor
or moderate injury.
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https://www.zeiss.com/corporate/int/home.html
https://www.zeiss.com/corporate/int/home.html


ZEISS 1 General Information | 1.3 Further Applicable Documents

NOTICE

Type and source of danger
NOTICE indicates a potentially harmful situation which, if not avoided, may result in property
damage.

Info
Provides additional information or explanations to help users better understand the contents
of this Instruction Manual.

1.3 Further Applicable Documents

SmartSEM Software Manual

For detailed information on how to use the SmartSEM software for imaging and hardware con-
trol, refer to the SmartSEM software manual.

SmartFIB Software Manual

For detailed information on how to use the SmartFIB software for ion beam exposure, refer to the
SmartFIB software manual.

Instruction Manual for Options

For detailed information regarding optional accessories, refer to the respective instruction manual
in your document folder.

Product Specification and Installation Requirements

For details on technical data, refer to the documents Product Specification and Installation Re-
quirements.

Material Safety Data Sheets

Material safety data sheets (MSDS) of chemicals used in combination with the microscope are
contained in the document folder delivered with the microscope.
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1.4 Contact

If you have any questions or problems, please contact your local ZEISS Sales & Servicepartner or
one of the following addresses:

Headquarter

Phone: +49 1803 33 63 34

Fax: +49 3641 64 3439

Email: info.microscopy.de@zeiss.com

Service Germany

Phone: +49 7364 20 3800

Fax: +49 7364 20 3226

Email: service.microscopy.de@zeiss.com

Courses and training

Email: courses.microscopy.de@zeiss.com

ZEISS Sales & Servicepartner

You can find a ZEISS Sales & Servicepartner in your area under https://www.zeiss.de/mikroskopie/
website/forms/sales-and-service-contacts.html.
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2 Safety
This chapter contains general requirements for safe working practices. Any person using the Mi-
croscope System or commissioned with installation or maintenance must read and observe these
general safety instructions. Knowledge on basic safety instructions and requirements is a precon-
dition for safe and fault-free operation. Operational safety of the supplied Microscope System is
only ensured if it is operated according to its intended use.

If any work is associated with residual risks, this is mentioned in the relevant parts of this docu-
ment in a specific note. When components must be handled with special caution, they are
marked with a warning label. These warnings must always be observed.

2.1 Intended Use

The microscope has been designed to generate an image or to analyze appropriate specimens,
which is achieved by scanning a focused electron or ion beam across the specimen.

In addition to microscopic examination, the microscope also allows for the modification of appro-
priate specimens. For these purposes, the specimen is placed in the evacuated specimen chamber.

The microscope has been designed for the following applications:

§ Imaging
Image generation and specimen analysis can be performed by means of a focused electron
beam (SEM Imaging) or a focused ion beam (FIB Imaging) that is scanned across the speci-
men.
This application allows for the analysis of surface structures and near-surface structures of ap-
propriate specimens.

§ Milling
Milling comprises all applications that include material removal from the specimen surface by
a focused ion beam.

In combination with a gas injection system option, the microscope has been designed for the fol-
lowing applications:

§ Gas-assisted deposition 
A process gas in combination with either a focused electron beam or a focused ion beam can
be used to deposit material onto the specimen surface.

§ Gas-assisted etching
This application enables an accelerated material removal by a focused electron beam or a fo-
cused ion beam in combination with a process gas.

Info
Not for therapeutic, treatment or medical diagnostic evidence.

Info
Not all products are available in every country. Contact your local ZEISS representative for
more information.

SmartSEM Software

The SmartSEM software is intended for the operation of scanning electron microscopes (SEMs).

The SmartSEM software has to be run exclusively on a personal computer delivered by ZEISS. Any
other applications are not allowed.

Regarding the operation of the microscope, the following regulations must be met:

§ Only operate the microscope according to the operating conditions after correct installation
by a ZEISS service representative.
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§ The microscope is only to be used by operators who have been trained by a ZEISS service rep-
resentative. Basic operator training and safety instructions will be provided within the scope
of the initial start-up by ZEISS. Make sure that everyone who operates the microscope only
performs the tasks for which he/she is trained.

§ Operators of the microscope must not deviate from the instructions provided in this manual.

§ Only perform preventive maintenance tasks described in this manual. All tasks of mainte-
nance, service, and repair not described in this manual have to be performed by an authorized
ZEISS service representative.

§ The microscope is to be used in a laboratory environment for commercial and scientific pur-
poses only.

Using the microscope for any other purpose is not allowed and can be hazardous.

2.2 Safety Procedures

2.2.1 Safe Operation Conditions

If the product safety labels are covered or worn or if any of the safety devices are not in proper
working condition, operation of the microscope can be hazardous.

§ Periodically check the function of safety equipment.

§ Periodically check that all protective cover panels are installed.

§ Always follow the instructions given on the safety labels.

§ Inspect and clean the product safety labels to maintain good legibility.

2.2.2 Requirements for Personnel

Deviating from the instructions given in this manual and on the safety labels can be hazardous or
can lead to property damage.

§ Do not operate the microscope until you have completely read and understood the entire user
documentation delivered with the microscope.

§ Observe all safety labels on the microscope and within this manual.

§ Only operate the microscope according to the operating conditions after correct installation
by a ZEISS service representative.

§ Only ZEISS service representatives, who have specialized knowledge of radiation protection,
are permitted to service the microscope.

Operator Training

Within the scope of initial start-up, the ZEISS service representative will perform a basic operator
training. The basic operator training consists of fundamental operation procedures including
safety instructions. Besides, an introduction to basic maintenance tasks will be given for an ad-
vanced operator, who has to be an electrically skilled person. The training performed must be
documented appropriately.

Special application training is offered on request.

2.2.3 Preventive Maintenance

Deviating from the maintenance and repair tasks described in this manual can be hazardous or
can lead to property damage.

§ Only perform preventive maintenance and repair tasks described in this manual.

§ All tasks of maintenance, service, and repair not described in this manual have to be per-
formed by an authorized ZEISS service representative.
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§ To maintain best performance of the microscope, it is essential to perform preventive mainte-
nance on a regular basis. Moreover, it is recommended that you conclude a service contract
with your local ZEISS service representative or organization.

2.2.4 Safe Handling of Spare Parts

Using spare parts that are not provided by ZEISS can be hazardous or can lead to property dam-
age:

§ Only genuine parts supplied by ZEISS are to be used in servicing the microscope.

§ Contact your ZEISS service representative for information regarding how to order spare parts.

§ Unless authorized by ZEISS, all spare parts should be installed by a ZEISS service representa-
tive.

2.3 Prevention of Hazards

This section summarizes potential hazards and recommended safety precautions. Failure to follow
the safety instructions and instructions may result in personal injury and property damage.

2.3.1 Biological Hazards

Danger to life:
Biological

substances

Biological substances may pose a threat to the health of humans and other living organisms.

§ Keep a logbook of the biological substances loaded into the microscope and show it to the
ZEISS service representatives before they perform any work on the microscope.

2.3.2 Burn Hazards

Risk of property
damage: Hot

surfaces during
bakeout

Parts of the enclosure in the upper range of the column may become hot during bakeout, particu-
larly after a long bakeout cycle.

§ Do not place any combustible objects on the grids of the electron optical column during bake-
out.

§ After the bakeout procedure, let surfaces cool down before working around the column.

§ Only advanced operators are allowed to perform the bakeout procedure.

2.3.3 Chemical Hazards

Risk of injury:
Aggressive or toxic

chemicals

Aggressive or toxic chemicals can cause chemical burns.

§ When handling aggressive or toxic chemicals, wear suitable protective clothing, gloves, and
eye/face protection.

§ Do not eat, drink, or smoke while handling toxic chemicals.

§ Refer to local safety regulations.

§ Read and follow the instructions in the material safety data sheet of the chemical. The mate-
rial safety data sheet can be obtained from the supplier of the chemicals.

Risk of injury:
Reaction products

Dangerous reaction products can be present in the specimen chamber during or after operation.

§ Ensure that there is an appropriate exhaust gas line to remove the waste gas of the pre-vac-
uum pump and to transmit it to the outside.

§ Wear lint-free gloves when touching the inner parts of the specimen chamber or the speci-
men.

Risk of injury:
Irritant gases

If a gas injection system (GIS) is used, irritant gases might be released from the precursors. Gases
can cause irritation to eyes, skin, and respiratory system.

§ Do not remove a reservoir from the gas injection system.

§ Contact your ZEISS service representative to have an empty reservoir replaced.
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§ Never try to open a reservoir.

§ For further information, refer to the GIS instruction manual.

Environmental
risk: Disposal of

aggressive or toxic
chemicals

When disposing of aggressive or toxic chemicals, there is a threat of damage to the environment.

§ When disposing of waste that has been generated during a service operation (e.g. used rotary
pump oil), comply with all national and local safety and environmental protection regulations.

2.3.4 Electrical Hazards

Danger to life:
Hazardous voltage

inside the
microscope

High voltages are present inside the microscope. Contact may cause burn or electrical shock.

§ Ensure proper grounding. For more information, refer to the Installation Requirements docu-
ment.

§ Only authorized ZEISS service representatives are allowed to service the microscope.

§ Do not try to service the microscope yourself.

Danger to life:
High leakage

currents

High leakage currents are present in the microscope. Contact may cause burn or electrical shock.

§ Ensure proper grounding. For more information, refer to the Installation Requirements docu-
ment.

§ Do not operate the microscope without the separate ground connection.

2.3.5 High Pressure Hazards

Risk of injury or
property damage:

High pressure in
gas cylinders

Gas cylinders containing for example nitrogen or compressed air have a high internal pressure of
approximately 200 bar. If not properly handled, the contained gas can abruptly escape and cause
the gas cylinder to move in an uncontrollable manner.

§ Observe all safety labels on the gas cylinders and all safety instructions given by the gas cylin-
der manufacturer.

§ Always operate gas cylinders in an upright position and secure them so they will not tip over.

§ Before transporting gas cylinders, place protective caps on them.

2.3.6 Magnetic Field Hazards

Risk of injury:
Malfunction of

medical devices
near ion getter

pumps

Magnetic fields present at the ion getter pumps may disturb the function of medical devices. The
magnetic fields are also present if the microscope is switched off.

If you wear medical implants that are susceptible to magnetic fields (e.g. cardiac pacemakers), do
the following:

§ Keep a distance of at least 1 m from the ion getter pumps.

§ Follow the safety instructions provided by the pump manufacturer.

2.3.7 Mechanical Hazards

Risk of injury:
Moving the

specimen stage

Fingers can be trapped by the moving specimen stage.

§ Always close the chamber door before moving the specimen stage.

§ To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your fin-
gers.

Risk of injury:
Closing the

chamber door

Fingers can be pinched when closing the chamber door.

§ Use the recessed grip or door handle to close the chamber door.

§ Ensure not to get your fingers caught in the chamber door gap.
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Risk of property
damage: Short

working distance

When opening the chamber door, the microscope or specimen can be damaged if the specimen
stage is at a short working distance. If a BSD detector is inserted, it can be damaged as well.

§ Always move the specimen stage to a long working distance before opening the chamber
door.

2.3.8 Radiation Hazards

Danger to life: X-
rays

X-rays are generated inside the microscope during operation. This is unavoidable because elec-
trons are accelerated by voltages up to 30 kV.

§ Do not remove any parts around the column and chamber that are essential for radiation pro-
tection.

§ Use genuine ZEISS parts exclusively.

§ Ensure that all local safety and X-ray protection regulations are met.

§ Only authorized ZEISS service representatives are allowed to service the microscope.

The microscope is equipped with several radiation protection devices, which, under regular oper-
ating conditions, ensure that the microscope operates in accordance with the German X-ray pro-
tection regulation (RöV), the German radiation protection regulation (StrSchV) as well as with the
EC Directive 2013/59/EURATOM.

In the EU, the operation of the microscope is permission-free as the following requirements are
fulfilled:

§ The acceleration voltage is limited to 30 kV.

§ The local dose rate at a distance of 0.1 m from the accessible surface of the microscope does
not exceed 1 μSv/h.

§ A respective label is attached to the microscope.

Outside the EU, the user of the microscope has to comply with the local regulations of the coun-
try where the microscope is operated.

Radiation Protection

For questions regarding radiation protection, contact the ZEISS Radiation Safety Officer, Carl Zeiss
AG, 73447 Oberkochen, Germany

phone: +49 (0) 7364 20 0

2.3.9 Suffocation Hazards

Danger to life:
Lack of oxygen

Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange and parts
exchange. Inhaling nitrogen may cause unconsciousness.

§ During specimen exchange, keep the chamber door open as short as possible.

§ Do not inhale the air from within the specimen chamber.

§ Ensure that the area around the microscope is sufficiently ventilated.

§ If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of mental
alertness and/or muscular coordination, depression of sensations, emotional instability, fa-
tigue) leave the room immediately and inform the facility’s safety officer.

Concerning the hazards of nitrogen installations and associated safety precautions refer to the
current version of the guideline IGC Doc 44/18: Hazards of Oxygen-Deficient Atmospheres, pub-
lished by EIGA (European Industrial Gases Association).

To download the document:

1. Go to EIGA homepage www.eiga.eu.

2. Select Publications > EIGA Documents.

3. From the list, select Doc. 44/18.

4. Click Download.
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2.4 Safety Equipment

In order to prevent hazards to human health or property damage, the microscope is equipped
with several safety features.

2.4.1 Protective Cover Panels

Due to hazardous voltages and X-rays inside the microscope, the microscope is equipped with
protective cover panels.

1

2

3

Fig. 1: Protective cover panels

1 Electron optical column protective cover panels

2 Specimen chamber protective cover panels

3 Plinth protective cover panels

Operation of the microscope is only allowed with attached protective cover panels.
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2.4.2 Main Switch

The Main Switch cuts off both phases of the mains power from the microscope.

The Main Switch guarantees an ampere interrupting capacity (AIC) of at least 10,000 A rms. In the
OFF position, the Main Switch can be secured with a padlock against inadvertent activation, for
example during repair and maintenance work.

The Main Switch is located at the rear side of the plinth.

Fig. 2: Main Switch

2.4.3 Emergency Off (EMO) Option

With the Emergency Off (EMO) option, the microscope is equipped with the following additional
safety equipment. 
Microscopes with SEMI certification must be equipped with the Emergency Off (EMO) option.

Emergency Off (EMO) Button

The EMO button is located on the plinth adjacent to the specimen chamber.

The EMO button must be pressed in an emergency to cut off mains power from the microscope
and all devices connected to the AC Unit.

The EMO button must always be readily accessible and operable.

Up to three additional EMO buttons may be connected.

Fig. 3: EMO button
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S2 (Start) Button

The green S2 (Start) button is attached below the MAIN switch at the rear side of the plinth.

The S2 (Start) button is required to confirm the setting of the MAIN switch. It cuts off all devices
connected to the EMO box from the main power supply.

The S2 (Start) button must be pushed in the following cases:

§ After the MAIN switch has been set to the ON position, or

§ After the EMO button has been released.

Fig. 4: S2 (Start) button below the MAIN switch

2.4.4 Locking Devices

The microscope is equipped with several locking devices.

2.4.4.1 Chamber Door Locking Device

The chamber door locking device ensures that the door of the specimen chamber is closed prop-
erly.

It is located at the inner bottom front side of the specimen chamber.

When this locking device is activated (i.e. no electrical contact) EHT Vac ready = no is indi-
cated in the SmartSEM user interface. EHT and SE detector voltages are blocked.

2.4.4.2 Vacuum Locking Device

The vacuum locking device ensures that gun vacuum and system vacuum are better than the re-
quired thresholds.

2.4.4.3 Interlock System of Optional Airlock

The interlock function ensures that the gate valve can only be operated if the chamber door and
the airlock door are properly closed.

Fig. 5: Airlock Error LED

Additional blocking functions ensure that the specimen can only be transferred if the following
conditions are fulfilled:

§ The airlock rod is retracted.

§ The specimen stage is in transfer position.

§ The EHT (Extra high tension) is off.

§ The column chamber valve is closed.

This is to prevent any risk of damaging the airlock rod or the gate valve.
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2.4.5 Lockout/Tagout Equipment

The Lockout/Tagout (LOTO) equipment isolates the workstation from potential hazards associated
with the unexpected release of hazardous energy.

Performing a Lockout/Tagout [} 93] can be necessary during

§ maintenance tasks

§ service work

§ unscheduled repairs

At the site of installation, the electrical power connection and the fluid connections must be
equipped with energy isolating devices.

These energy isolating devices (main shut-off devices)

§ must be easily accessible

§ must be mounted near the microscope in such a way that the person actuating or inspecting
an energy isolating device is not be exposed to serious risks

§ must close off the connections to the corresponding media when needed

§ must be lockable in their off position in order to prevent accidental re-activation

The customer is responsible for

§ having a working knowledge of the LOTO specification

§ purchasing, distributing, and installing appropriate LOTO equipment

§ auditing and enforcing compliance with LOTO procedures to all authorized personnel

§ providing instructions on how to operate the energy isolating devices properly

Required Energy Isolating Devices

§ Branch circuit molded case circuit breaker

§ Main shut-off valves
– Nitrogen supply
– Compressed air supply
– Cooling water supply
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2.4.6 Safety Labels

Appropriate safety labels on the microscope warn operators of hazards. Each safety label is af-
fixed close to the point where a particular hazard exists. Several labels also provide legal informa-
tion.

Labels Attached to the Front Side of the Microscope

1

2

3

Labels Attached to the Rear Side of the Microscope

4

5

6
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Labels Attached to the Gun Head underneath the Cladding

8

9

Labels Attached to the Rear Side of the Plinth

7

9

8

Labels Attached to the CEE Connector

14

16

The safety labels always need to be attached to the correct spots at the microscope. If a safety la-
bel is lost or unreadable, it needs to be reordered via the following reorder numbers:
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Position and Figure of the Safety La-
bel

Description

1  At the front of the chamber door.

CAUTION
 

Risk of injury

347800-0033-000-02en

Fingers could be trapped.

Always close the chamber door
before you move the stage.

Risk of injury

Fingers could be trapped. Always close the cham-
ber door before you move the stage.

Reorder no. 347800-0033-000-02en

2  At the front of the chamber door.

Risk of damage

CAUTION

347800-0033-000-04en

The FESEM or specimen could be
damaged if specimen stage is at a

short working distance.
Move the specimen stage to a long

working distance before opening
the chamber door.

Risk of damage

The FESEM or specimen could be damaged if
specimen stage is at a short working distance.

Move the specimen stage to a long working dis-
tance before opening the chamber door.

Reorder no. 347800-0033-000-04en

3  At the front of the plinth

Avoid injury

CAUTION

347800-0033-000-01en

Make sure you have read and 

understood the instruction 
manual before operating this 

product.

 

Avoid injury

Make sure you have read and understood the in-
struction manual before operating this product.

Reorder no. 347800-0033-000-01en

4  At the rear of the electron optical
column

Contact may cause burn or electric
shock. Only authorised service

Staff is allowed to service the 
equipment.

Disconnect power before opening.

Hazardous voltage inside

WARNING

347800-0033-000-03en

 

Hazardous voltage inside

Contact may cause burn or electric shock. Only
authorized service Staff is allowed to service the
equipment.

Disconnect power before opening.

Reorder no. 347800-0033-000-03en

5  At the ion getter pumps
 

Magnetic field

WARNING

Can be harmful to pacemaker 

wearers. 

Pacemaker wearers stay back 

30cm (12 in.).

H6048/6063-NCWHPU

Magnetic field

Can be harmful to pacemaker wearers.

Pacemaker wearers stay back 30cm (12 in.).

Reorder no. 360735-0000-034en

6  At the FIB column Hazardous voltage symbol

Reorder no. 360400-0000-215

7  At the rear of the microscope

WARNING
 

Suffocation hazard

347800-0033-000-08en

The specimen chamber is 
ventilated with gaseous nitrogen. 

Ensure that the area around the 
electron microscope is sufficiently 

ventilated.

Suffocation hazard

The specimen chamber is ventilated with gaseous
nitrogen.

Ensure that the area around the electron micro-
scope is sufficiently ventilated.

Reorder no. 347800-0033-000-08en
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Position and Figure of the Safety La-
bel

Description

8  At the rear of the microscope

WARNING
 

High leakage current

347800-0033-000-07en

Ensure proper grounding.
Do not operate the electron

microscope without a separate
ground connection.

High leakage current

Ensure proper grounding.

Do not operate the electron microscope without
a separate ground connection.

Reorder no. 347800-0033-000-07en

9  At the rear of the microscope Radiation hazard

Do not remove any parts.

Observe local safety and X-ray protection regula-
tions.

Service only through authorized personnel.

Reorder no. 347800-0033-000-06en

Liquid nitrogen

CAUTION

347800-0033-000-09en

Contact with liquid or cold vapors

can cause freeze burns or severe 
frostbite.

Wear face, eye and skin protection.

 For relevant options:

Liquid nitrogen

Contact with liquid or cold vapors can cause
freeze burns or severe frostbite.

Wear face, eye and skin protection.

Reorder no. 347800-0033-000-09en

Underneath the cover panels of the microscope, there are some more safety labels, which are ad-
dressed to authorized ZEISS service representatives. These safety labels are described in the docu-
ments for ZEISS service representatives.

Position and Figure of the Type Plate Description

At the rear of the microscope Type plate

Position and Figure of the Legal In-
formation

Description

At the rear of the microscope Caution

X-rays are produced in this Scanning Electron Mi-
croscope!

The acceleration voltage is limited to 30 kV.

Observe local safety and X-ray protection regula-
tions.

Order no. 346000-0088-000
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Position and Figure of the Type Plate Description

11  At the rear of the microscope The Type plate contains a unique serial number,
the Sigma model designation with the according
part number, the manufacturing year, and the
mains voltage for which the Sigma is configured.

Order no. 356100-9057-000 (Sigma 300)

Order no. 352100-9903-000 (Sigma 500)

Position and Figure of the Type Plate Description

13  At the rear of the microscope The Type plate contains a unique serial number,
the EVO model designation with the according
part number, the manufacturing year, and the
mains voltage for which the EVO is configured,
either 230 VAC or 120 VAC.

Order no. 354900-9040-000 (EVO10)

Order no. 354900-9041-000 (EVO15)

Order no. 354900-9042-000 (EVO25)
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3 Product and Functional Description

3.1 System Overview

Main Components 1

2

3

4

5

6

7

8

9

Fig. 6: Main components of the Microscope System

1 GEMINI II electron optical column

Refer to Electron Optical Column | Gem-
ini II [} 31]

2 Ion getter pumps (IGPs) for FIB

3 Ion-sculptor focused ion beam (FIB) col-
umn

Refer to Ion-sculptor Focused Ion Beam
(FIB) Column (Optional) [} 35]

4 Specimen chamber with door handle

5 Plinth with ON/STANDBY/OFF buttons 6 Monitor

7 Work desk 8 Dual joystick

Refer to Dual Joystick [} 43]

9 Personal Computer (PC)

Optional
Components and

Accessories

4

3

2

1
5

6

7

8

9

Fig. 7: Optional components and accessories
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1 Multichannel Gas Injection System (GIS)
for up to 5 precursor materials on a sin-
gle flange

Refer to instruction manual Multi GIS

2 Annular STEM detector (aSTEM) for
transmission imaging and quality con-
trol. Two different models are available
(aSTEM4, aSTEM1). Detection of up to
4 channels in parallel is possible.

Refer to aSTEM Detector [} 50]

3 Local charge compensator for SEM
imaging and analysis of non-conductive
specimens

Refer to instruction manual Charge
Compensator

4 Electron flood gun for ion beam prepa-
ration of non-conductive specimens

Refer to instruction manual Flood Gun

5 Single needle GIS for high angle speci-
men access

Refer to instruction manual UniGIS

6 Micro-manipulator for specimen modifi-
cation and probing

7 BSD detector for high efficiency BSE de-
tection and angle selective material
characterization. Four different models
are available (aBSD4, aBSD1, BSD4,
BSD1). Detection of up to 4 channels in
parallel is possible.

Refer to BSD Detector [} 46] and aBSD
Detector [} 47]

8 EsB detector for finest z resolution with-
out topographic artifacts and unique
material contrast

Refer to EsB Detector [} 45]

9 Airlock with optional navigation camera
(80 mm or 200 mm wide) for fast and
efficient specimen transfer and fast
pumping times

Refer to the respective instruction man-
ual 80 mm Airlock or 200 mm Airlock

Further options:

§ Control panel

Refer to Control Panel [} 53]

§ Plasma Cleaner

Refer to instruction manual Plasma Cleaner

§ Energy-dispersive X-ray spectrometer (EDS) for chemical analysis

§ EBSD for crystallographic mapping

§ SESI detector for Secondary Electron and Secondary Ion imaging

Refer to SESI Detector [} 44]

§ CL detector for the analysis of cathodoluminscent materials

Refer to CL Detector [} 52]

§ Nanopatterning and Visualization Engine (NPVE) for advanced patterning and lithography
tasks

Information will be provided by the manufacturer

§ Electrostatic Beam Blanker for SEM

Refer to instruction manual Beam Blanker

§ Rapid Laser Ablation Upgrade

Refer to instruction manual Rapid Laser Ablation Upgrade

§ Further options on request
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3.2 Main Components

3.2.1 Vacuum System

Purpose For operation of the microscope, the gun head, the column, and the specimen chamber have to
be evacuated. The vacuum is essential to operate the gun and to prevent collisions of electrons
with gas molecules.

1

2

3

4

5

8

9

10

6

7

Fig. 8: Schematics of the vacuum system of a microscope with Gemini II column

1 Gun with filament

2 Gun head

3 Single hole aperture

4 Column chamber valve

5 Turbo pump

6 Ion getter pumps (IGP)

7 Specimen chamber

8 Penning gauge

9 Vent valve

10 Pre-vacuum pump

Operating
Principle

System Vacuum

The pre-vacuum pump 10  and the turbo pump 5  evacuate the specimen chamber 7 .
The vacuum in the specimen chamber is measured by a Penning gauge 8 . The detected vac-
uum values are displayed as System vacuum in the SmartSEM user interface. As long as the de-
tected pressure in the specimen chamber is not ready for operation, the column chamber valve

4  is closed in order to separate the specimen chamber from the column.
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Gun Vacuum

In the gun head, an ultra high vacuum is maintained by ion getter pumps 6 . The vacuum in
the gun head is displayed as Gun vacuum in the SmartSEM software. It should be below
1 × 10⁻⁸ mbar.

Venting

The specimen is located in the evacuated specimen chamber. To open the specimen chamber for
specimen exchange, you have to break the vacuum in a controlled manner. This is done by the
Vent command via the SmartSEM user interface or by pressing the Exchange push button on the
optional control panel.

When the Vent command is received, the column chamber valve closes and gaseous nitrogen
flows into the specimen chamber via the vent valve 9 . As soon as the pressure equilibrium is
obtained, the chamber door can be opened to change the specimen.

Evacuating

In order to continue operation, the Pump command makes the pre-vacuum pump and the turbo
pump evacuate the specimen chamber.

As soon as the vacuum in the specimen chamber is ready for operation, the column chamber
valve opens and the EHT Vac ready message is displayed in the SmartSEM user interface. Gun and
EHT can be switched on.

Quiet Mode

The automatically controlled Quiet Mode is optionally available. This option allows switching off
the pre-vacuum pump after specimen exchange when the vacuum threshold is achieved.
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3.2.2 Electron Optical Column | Gemini II

Purpose The GEMINI II column is the part of the microscope, where electrons are emitted, accelerated, de-
flected, focused, and scanned. Main characteristics of the GEMINI optics are the beam booster
and an objective lens that consists of a combined electrostatic/electromagnetic lens doublet.

U
Sup

U
Ext

U
EHT

U
B

1

2

3

4

5

6

7

8

9

10

11

Fig. 9: Schematics of the electron optics

1 Gun

2 Extractor

Positive electrode that extracts electrons from the filament.

3 Anode aperture

4 Upper condenser

5 Single hole aperture

6 Lower condenser

7 EsB detector

8 InLens SE detector

9 Objective lens

Focuses the electron beam on to the specimen surface.

10 Scanning coils

Deflect the beam across the specimen surface in what is usually referred to as a raster
scan.

11 Specimen

USup Suppressor voltage

UExt Extractor voltage

UEHT Acceleration voltage

UB Liner tube voltage
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Operating
Principle

Gun

A Schottky field emitter serves as gun 1 . The filament is heated by applying the filament cur-
rent. Electrons are emitted from the heated filament while an electrical field, called extractor volt-
age (UExt), is applied. To suppress unwanted thermionic emission from the shank of the Schottky
field emitter, a suppressor voltage (USup) is applied as well.

EHT

The emitted electrons are accelerated by the acceleration voltage (UEHT). The beam booster (UB,
booster voltage), which is always at a high potential if the acceleration voltage is 20 kV or less, is
integrated directly after the anode. This guarantees that the energy of the electrons in the entire
beam path is always much higher than the set acceleration voltage. This considerably reduces the
sensitivity of the electron beam to magnetic stray fields and minimizes the beam broadening.

Apertures

The electron beam passes through the anode aperture 3  first, afterwards through a single
hole aperture 5 .

The anode aperture defines the maximum possible probe current.

For the Gemini II column, two different column configurations are available:

§ 40 nA high resolution configuration

Anode aperture diameter Probe current Typical application

55 μm* 10 pA to 40 nA High resolution

§ 100 nA high current configuration

Anode aperture diameter Probe current Typical application

90 μm* 10 pA to 100 nA Combined high resolution
and analytical investigations

Condenser

A double condenser system allows the continuous regulation of the probe current. The upper
condenser 4  is used to continuously adjust the probe current. The lower condenser 6  is
used for aperture matching of the objective lens in order to guarantee optimum resolution at
each probe current and EHT setting.

Stigmator

The stigmator is located inside the condenser and compensates for astigmatism so that the elec-
tron beam becomes rotationally symmetrical.

Deflection System

The electron beam is focused by the objective lens 9  onto the specimen 11  while being de-
flected in a point-by-point scan over the specimen surface by the scanning coils.

Before the electron beam exits the objective lens, the electrostatic lens creates an opposing field
which reduces the potential of the electrons by +8 kV. The energy of the electrons reaching the
specimen surface therefore corresponds to the set acceleration voltage (EHT).

Signal Detection

When the primary electron beam hits the specimen, certain interaction products are released,
which can be recorded by specific detectors, e.g. the InLens SE detector 8 . For more informa-
tion see Principle of Signal Detection [} 37].
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3.2.2.1 Beam Modes

With the GEMINI II column, different beam modes are available:

§ High Resolution

§ High Resolution Low Current

§ Normal

§ Minimum Probe Current

§ Maximum Probe Current

§ Fisheye

§ Widefield

High Resolution

Characteristics Beam Path

The upper condenser 1  has a low excitation which is var-
ied in order to adjust the probe current in a limited range.

§ Electron interaction effects are minimized

§ High spatial resolution is guaranteed

§ Probe current range is limited
1

High Resolution Low Current

The characteristics and the beam paths of the High Resolution Low Current mode and High Reso-
lution mode are the same, except the different operation of the gun.
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Normal

Characteristics Beam Path

The upper condenser 1  focuses the beam and creates a
crossover above the beam-limiting aperture 2 . The upper
condenser is adjusted to modify the probe current.

The lower condenser 3  is used for aperture matching of
the objective lens 4  for optimum spatial resolution.

§ Whole probe current range is accessible

§ High spatial resolution is usually guaranteed

Instead of aperture matching it is also possible to adjust the
amount of depth of field desirable. The lower condenser

3  is then operated at increasing excitations.

§ Provides a higher depth of field

§ Useful to investigate specimens with a high aspect ratio
or to navigate on a tilted specimen

1

2

3

4

Minimum Probe Current

The characteristics and the beam paths of Minimum Probe Current mode and Normal mode are
the same, except the different operation of the gun.

Maximum Probe Current

The characteristics and the beam paths of Maximum Probe Current mode and Normal mode are
the same, except the different operation of the gun.

Fisheye

§ Provides a huge field of view, allows you to image the whole specimen holder with the elec-
tron beam.

§ Useful for an overview of large specimens and for specimen navigation.

Widefield

§ Provides a huge field of view, allows you to image the whole specimen holder with the elec-
tron beam.

§ Useful for an overview of large specimens and for specimen navigation.

§ Can be used with EHTs between 100 V and 2000 V.

§ Requires the SmartSEM software license Field Mode.
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3.2.3 Ion-sculptor Focused Ion Beam (FIB) Column (Optional)

Purpose The Ion-sculptor Focused Ion Beam (FIB) column is the part of the microscope, where ions are
emitted, accelerated, focused, and deflected.

1

2

3

4

5

Fig. 10: Schematics of the ion optics

1 Ion source

Liquid metal ion source of gallium (Ga⁺).

2 Variable apertures

3 Ion beam

4 Objective lens

5 Specimen

Operating
Principle

Gallium ions (Ga⁺) are extracted from a liquid metal ion source 1 . The ions are accelerated by
the acceleration voltage to an energy of maximum 30 keV. The ion emission is adjusted by the ex-
tractor and the suppressor voltage.

Gallium is used up during operation. Therefore, the gallium emitter cartridge is a consumable.

The gallium emitter has to be regenerated by heating from time to time; the heating procedure
removes the gallium oxide, which has been created during operation.

Condenser

The electrostatic condenser collimates and focuses the ion beam.

Probe Currents

After passing the condenser, the beam current is defined by a set of software-controlled mechani-
cal apertures. By using the different apertures in combination with the different condenser set-
tings, the probe current can be continuously adjusted in the range between 1 pA and 100 nA.

Objective Lens

The objective lens is designed as an electrostatic Einzel-lens system. It focuses the beam onto the
specimen surface.
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3.2.3.1 Imaging Modes

Purpose With the FIB option, different imaging modes are available to operate the microscope.

1 2 3

Fig. 11: Imaging modes available with the FIB option

Imaging Mode FIB Mode Characteristics Typical Application

1  SEM imaging SEM § Electron beam is active.

§ Ion beam is blanked.

§ The SE signal is synchronized
to the SEM scan.

High resolution imaging.

2  FIB imaging FIB § Electron beam is blanked.

§ Ion beam is active.

§ The SE signal is synchronized
to the FIB scan.

§ Channeling contrast imaging.

§ Voltage contrast imaging.

§ Defining milling patterns on the
specimen surface.

§ Grain analysis.

3  Crossbeam
operation

SEM + FIB Image is composed of SEM and
FIB components.

Setting the coincidence point.

Mill § No image.

§ Mills with the milling parame-
ters set (milling current).

§ Ion beam milling or ion beam
deposition.

Mill + SEM Mills and generates a SEM image. SEM real-time imaging of the ion
beam milling or deposition.
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3.2.4 Detectors

3.2.4.1 Principle of Signal Detection

The interaction products most frequently used for the generation of images in scanning electron
microscopy are secondary electrons (SEs) and backscattered electrons (BSEs).

Primary Electrons (PEs)

Primary electrons are electrons forming the scanning beam before hitting the specimen.

Secondary Electrons (SEs)

Secondary electrons are emitted from the topmost layer of the specimen.

§ SE1 Electrons

Electrons emitted at the point of impact between the beam and the specimen are known as
SE1 type electrons. The amount of electrons emitted at the point of impact is related to the
shape of the specimen.

Secondary electron detectors, such as the InLens SE detector, collect SE1 type electrons from
the surface layer of the specimen and are thus ideal for displaying surface structures.

§ SE2 Electrons

The emergence of backscattered electrons from the specimen excites further emission of sec-
ondary electrons. These are known as SE2 type electrons.

Detectors that collect SE2 type electrons are especially suitable where the working distance is
large. Surface detail as the effect of “lateral illumination” emphasizes the topography of the
specimen.

Backscattered Electrons (BSEs)

Backscattered electrons (BSEs) emerge from below the surface of the specimen (up to an order
of µm). The number of electrons emitted at the point of impact is highly dependent on the mean
atomic number of the specimen material. This means that a BSE image provides depth informa-
tion and atomic number contrast.

BSE detectors are used to display the materials contrast because the backscatter coefficient is de-
pendent on the mean atomic number of the material under investigation.

Transmitted Electrons

This comprises primary electrons that are transmitted through an ultrathin specimen and weakly
scattered primary electrons with a small range of angles. Depending on the material, primary elec-
trons are scattered under different angles and can be detected by a STEM detector placed below
the specimen. Unscattered electrons are detected in the center of the STEM detector and give a
bright field image. Electrons scattered under higher angles are detected by outer areas of the
STEM detector and produce dark field images.

Cathodoluminescence (CL)

Electrons impacting on luminescent materials cause the emission of photons which may have
wavelengths in the visible spectrum and can be imaged by specialized detectors.
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3.2.4.2 Detectors Overview

The beam scans the specimen and initiates particles to be emitted. A detector collects the emis-
sion and produces an electric signal with an amplitude proportional to the number of particles at
any given time.

Standard Detectors Detected Signals Typical Application

InLens SE Detector [} 39] SE1 Surface structure

SE Detector [} 40] SE2 Topography

Optional Detectors Detected Signals Typical Application

SESI Detector [} 44] SE2

Ions

Channeling contrast (crystal
orientation)

Compositional contrast

EsB Detector [} 45] SE1

BSE

Surface structure

Material contrast

BSD Detector [} 46] BSE Compositional contrast

aBSD Detector [} 47] BSE Angular resolved BSE imag-
ing

Compositional contrast

aSTEM Detector [} 50] Transmitted electrons Diffraction contrast

Compositional contrast

CL Detector [} 52] Light photons Mineralogy
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3.2.4.3 InLens SE Detector

Purpose The InLens SE detector is a high-efficiency detector for high resolution SE imaging and detects
secondary electrons directly in the beam path. The detection efficiency of this detector results
from its geometric position in the beam path and from the combination with the electrostatic/
electromagnetic lens.

Position The annular shaped in-column detector is located above the objective lens.

1

2

3

4

Fig. 12: Schematics of the InLens SE detector

1 InLens SE detector

2 Beam path

3 Objective lens

4 Specimen

Operating
Principle

The primary electrons are accelerated by the acceleration voltage at the anode and, up to an ac-
celeration voltage of 20 kV, by an additional beam booster voltage of 8 kV at the liner tube. To
ensure that the electrons reach the specimen surface 4  with the energy set as acceleration
voltage, an opposing electrostatic field of the same magnitude as the beam booster voltage (8 kV)
is generated at the end of the objective lens by the electrostatic lens. This electrostatic field acts
as acceleration field for the SEs generated on the specimen surface.

At the InLens SE detector, the electrons hit a scintillator. This generates a flash of light that is led
out of the beam path and onto a photomultiplier by means of a lightguide. The photomultiplier
converts the light information into an electronic signal, which can be displayed on the monitor.

The efficiency of the InLens SE detector is mainly determined by the electric field of the electro-
static lens, which decreases exponentially with the distance.

Thus, the working distance (WD) is one of the most important factors affecting the signal-to-noise
ratio of the InLens SE detector.

As the tilt angle of the specimen surface affects the emission angle of the electrons, you should
avoid strong specimen tilting.

Info
The InLens SE detector can be used up to an acceleration voltage of 20 kV. At higher accelera-
tion voltages, the beam booster and thus the field of the electrostatic lens are switched off.
Without the field of the electrostatic lens, which attracts the secondary electrons, the effi-
ciency of the InLens SE detector is reduced.
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3.2.4.4 SE Detector

Purpose The SE detector is an Everhart-Thornley type detector. It detects SEs as well as BSEs.

Position The SE detector is attached to the options ports plate.

1

2

4
5

3

6

Fig. 13: Schematics of the SE detector

1 Preamplifier

2 Photomultiplier

3 Light guide

4 Scintillator

5 Collector grid

6 Specimen

Operating
Principle

Electrons moving to the detector are attracted/repelled by the collector grid and directed to the
scintillator. The electrons gain energy from the scintillator and thus are able to interact with a
phosphor layer, which generates photons (light). The light travels up a light pipe to a photomulti-
plier. The photomultiplier multiplies the flashes of light and outputs a signal that can be used for
imaging.

The collector voltage can be varied in the range between −250 V and +400 V.

A positive collector voltage generates an electrical field in front of the detector, thus directing the
low energy SEs towards the scintillator.

Info
For all standard applications, the collector bias should be set to +300 V.

3.2.4.5 Chamber CCD Camera

Purpose The microscope contains a CCD camera (charge-coupled device camera) inside the specimen
chamber. It is referred to as the chamber CCD camera or chamberscope. It allows you to monitor
the position of the specimen stage and particularly the distance between the objective lens and
the specimen holder.

The chamber CCD camera is located at the backside of the specimen chamber. A second CCD
camera can be installed on the left-hand side of the specimen chamber.
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1

2

3

Fig. 14: Sample image from chamber CCD camera.

1 Objective lens of the SEM column

2 Objective lens of the FIB column

3 Specimen holder

NOTICE

Risk of property damage: Risk of collision
Use the chamber CCD camera to monitor the position of the specimen holder during stage
movements. Pay particular attention to the distance between the objective lens and the top of
the specimen. This applies to vertical movements, but also to horizontal movements, because a
thick specimen may collide with the objective lens from the side.

The chamber CCD camera has two illumination modes. The chamber can be illuminated either
with white light or with infrared light. Infrared light gives a grayscale image, whereas white light
gives a color image. In standard settings the mode is automatically selected, depending on the
imaging mode and the selected detectors. White light limits the performance of most detectors.
Therefore infrared illumination is a fallback if white light cannot be used. The performance of
diode detectors is negatively affected by infrared light. If a diode detector is selected, then by de-
fault the chamber CCD camera is disabled. The automatic selection of the illumination mode can
be manually overwritten by the user.

The image of the chamber CCD camera can be adjusted by the user:

§ Brightness, contrast, and CCD illumination can be optimized to improve the image.

§ Certain display details can be chosen by zooming in and shifting. This can be achieved by
turning the Magnification and Shift X or Shift Y knobs on the control panel, respectively.

Info
It is highly recommended that the CCD illumination control is set to Auto Detect. This avoids
any problems by the user forgetting to switch the illumination back for a different detector.
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Fig. 15: Chamber CCD camera disabled as indicated by a pause sign (e.g. if a diode detector is
selected).

3.2.5 Specimen Stage

Purpose The motorized eucentric specimen stage is used to navigate the specimen inside the specimen
chamber.

Position The specimen stage is mounted on the chamber door. If the chamber door is closed, the speci-
men stage is inside of the specimen chamber.

1

2

Fig. 16: Specimen stage with dovetail fitting for precise fitting

1 Specimen holder

2 Specimen stage

Operating
Principle

When moving a tilted stage in X/Y direction, no displacement (moving out of focus) occurs. When
a pre-tilted specimen holder is used, X/Y movements require an adjustment of the Z position to
stay in focus.

The stage can be operated using the Dual Joystick [} 43] or using the SmartSEM software.

Axis Description Movement

X X-axis Movement towards or away from the cham-
ber door (horizontal movement in the image)

Y Y-axis Movement

Z Height Vertical movement (movement towards or
away from the focal plane of the image)

M Height Movement of the specimen surface into the
tilt axis at various working distances

R Rotation Stage rotation parallel to the X-Y plane

T Tilt Stage tilt about an axis parallel to the X axis
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The stage is eucentric, which means that the tilt axis intersects the beam axis. The specimen sur-
face is located in the eucentric point, where the tilt axis meets the beam axis. This guarantees that
the focus and the point of interest are maintained when the specimen is tilted at a certain work-
ing distance.

3.2.6 Dual Joystick

Purpose The dual joystick is used for stage control and specimen navigation.

Position The dual joystick is placed on the microscope desk.

2 31 4

Fig. 17: Dual joystick

1 T/Z joystick

Controls the Z axis and the stage tilt (T).

2 Break push button

Stops the stage in an emergency.

3 M push buttons

Controls a second Z-axis (M) on super-eucentric stages to set the eucentric point of the
specimen tilt on these stages.

4 X/Y/R joystick

Controls the X- and Y-axes and the stage rotation by turning.

Operating
Principle

All axes are deflection-compensated. When the joystick is moved only slightly, the respective axis
moves slowly. Larger movements of the joystick result in a faster movement of the stage.

The X-, Y-, and Z-axes are magnification-compensated. When working at a low magnification, the
stage moves relatively fast. At higher magnifications the stage movement is slower. The stage is
moving with its maximum speed when viewing the specimen with the CCD (Charge Coupled De-
vice) camera.

The different axes can also be moved simultaneously.
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3.3 Optional Components and Accessories

3.3.1 Optional Detectors

3.3.1.1 SESI Detector

Purpose The Secondary Electrons Secondary Ions (SESI) detector is suitable to detect secondary electrons
as well as secondary ions. In Crossbeam systems, the optional SESI detector replaces the SE detec-
tor.

1

2

4

5

3

Fig. 18: Schematics of the SESI detector

1 FIB column

2 Objective lens

3 SESI detector

4 Collector grid

5 Specimen

Operating
Principle

Depending on the polarity of the collector voltage, either electrons or ions scattered from the
specimen 5  are attracted by a collector grid 4  and accelerated to the converter. In the
converter, both electrons and ions are converted into secondary electrons which are used to gen-
erate an image.

Detector Mode FIB Mode Detected Signals Typical Application

SE mode

typical collector voltage +300 V

SEM, FIB Secondary electrons Topography

Ion mode

typical collector voltage −4 kV

FIB Secondary ions Crystal orientation contrast, ma-
terial contrast e.g. imaging of
corrosion/oxidation caused by FIB
processes in metals
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3.3.1.2 EsB Detector

Purpose The Energy-selective Backscattered (EsB) detector enables both SE and BSE detection. It can be
used for high contrast topography or for compositional contrast examinations.

The SEs and BSEs generated at the impact point of the primary electron beam are intercepted by
the low electrical field of the column. These electrons are accelerated by the field of the electro-
static lens.

Position The annular shaped in-column detector is located above the InLens SE detector.

1

3

2

1

3

2

Fig. 19: Schematics. SE detection via InLens SE detector (left) and BSE detection via EsB detector
(right)

1 EsB detector

2 Filtering grid

3 InLens SE detector

Operating
Principle

A small amount of SEs pass through the hole of the InLens SE detector 3  and would be ob-
served by the EsB detector 1 . To prevent detection of these SEs, a filtering grid 2  is in-
stalled in front of the EsB detector. By switching on the filtering grid voltage, the SEs are rejected
and only BSEs are detected.

Below a landing energy of 1.5 kV, the filtering grid 2  has the additional function of selecting
the desired energy of the BSEs. The operator can select the threshold energy of inelastically scat-
tered BSEs to enhance contrast and resolution.

The combination of InLens SE detector 3  and EsB detector 1  allows simultaneous imaging
and mixing of a high contrast topography (SE) and a compositional contrast (BSE).
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3.3.1.3 BSD Detector

Purpose The BSD detector is a pneumatically retractable backscattered electron detector. It is used for high
efficiency material characterization even at low-kV applications. It has four separate diode quad-
rants S1 to S4 and an additional shadow segment S5 for strong topography contrast.

Fig. 20: BSD detector with four diode quadrants and a fifth shadow segment

NOTICE

Risk of property damage: Motorized specimen stage
Risk of damaging the detector when operating the motorized specimen stage.

4 Retract the detector head completely after you have finished the work with the detector.

Info
Risk of malfunction: The diode segments are sensitive to the light that is used for illumination
in TV mode (infrared and white).

When you use a diode detector, always make sure that the TV illumination is switched off. If
the CCD Mode is set to Auto Detect, then the TV illumination is automatically switched off
when a diode detector is used.

The BSD detector has applications mainly in materials analysis and in the life sciences.

Material analysis:

§ Metallurgical sections

§ Geological sections

§ Complex materials

§ Printed circuit boards

§ Semiconductors

§ Bond pads

Life sciences:

§ Mineral deposits in plant structures

§ Bone structures

The BSD detector is available either with one video output channel (BSD1) or with four video out-
put channels (BSD4). With BSD4 you can collect four channels in parallel, which can be displayed
in Quad mode. Each channel can have an arbitrary combination of segments. This way, you can
collect compositional images, topographical images, and custom combinations all at once.
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Four channels are especially useful in combination with the program 3DSM, which provides a
topographical reconstruction of the specimen. The program 3DSM acquires four images of the
specimen and acquires each of these images with a different quadrant of the detector. This results
in four images from four different directions. With the BSD4 detector you can acquire these four
images all at once. An algorithm then calculates the topographic surface.

The BSD detector has a relatively large central hole and therefore has the advantage that it does
not limit the field of view of the SEM and does not influence the electron optical properties of the
objective lens. A disadvantage is that especially at low kV a lot of backscattered electrons are lost
in the central hole and cannot be detected. A solution for that is the aBSD detector.

Operating
Principle

On the surface of the specimen, some of the primary electrons are backscattered. The backscat-
tered electrons then move towards the silicon segments of the BSD detector. If the energy of the
backscattered electrons is high enough, then the electrons pass through the very thin dead layer
of the diode and create electron-hole pairs in the silicon segments.

In each individual segment, the charge separation due to the electron-hole pairs is measured as a
current, which is used as a signal for image generation. Only electrons that have a high enough
energy can create electron-hole pairs and can contribute to image generation. Electrons that have
a lower energy (e.g. secondary electrons) are not detected by the BSD detector.

The emission of backscattered electrons from a specimen is related to the atomic number of the
involved material: Elements with high atomic numbers generate more backscattered electrons (i.e.
the backscatter coefficient is higher). When imaging, regions that contain elements with higher
atomic numbers appear brighter. Regions that contain elements with lower atomic numbers ap-
pear darker.

Since the detector has a limited speed, it is recommended to use scan speed 6 or higher (slower),
especially at small magnifications. The lower the gain is, the faster is the detector.

3.3.1.4 aBSD Detector

Purpose The aBSD detector is a pneumatically retractable annular backscattered electron detector. It is
used for high efficiency and angle selective material characterization even at low-kV applications.
It has six separate diode segments, two inner concentric rings and four outer quadrants. The inner
segments provide mostly material contrast whereas the four outer quadrants provide more topo-
graphical contrast.

Fig. 21: The aBSD detector with two inner concentric segments and four outer quadrants

NOTICE

Risk of property damage: Motorized specimen stage
Risk of damaging the detector when operating the motorized specimen stage.

4 Retract the detector head completely after you have finished the work with the detector.

Instruction Manual ZEISS Crossbeam 550L, Crossbeam 550 | en-US | Rev. 3 | 349500-8122-000 47



3 Product and Functional Description | 3.3 Optional Components and Accessories ZEISS

Info
Risk of malfunction: The diode segments are sensitive to the light that is used for illumination
in TV mode (infrared and white).

When you use a diode detector, always make sure that the TV illumination is switched off. If
the CCD Mode is set to Auto Detect, then the TV illumination is automatically switched off
when a diode detector is used.

The BSD detector has applications mainly in materials analysis and in the life sciences.

Material analysis:

§ Metallurgical sections

§ Geological sections

§ Complex materials

§ Printed circuit boards

§ Semiconductors

§ Bond pads

Life sciences:

§ Mineral deposits in plant structures

§ Bone structures

The BSD detector is available either with one video output channel (BSD1) or with four video out-
put channels (BSD4). With BSD4 you can collect four channels in parallel, which can be displayed
in Quad mode. Each channel can have an arbitrary combination of segments. This way, you can
collect compositional images, topographical images, and custom combinations all at once.

Four channels are especially useful in combination with the program 3DSM, which provides a
topographical reconstruction of the specimen. The program 3DSM acquires four images of the
specimen and acquires each of these images with a different quadrant of the detector. This results
in four images from four different directions. With the BSD4 detector you can acquire these four
images all at once. An algorithm then calculates the topographic surface.

The BSD detector has a relatively large central hole and therefore has the advantage that it does
not limit the field of view of the SEM and does not influence the electron optical properties of the
objective lens. A disadvantage is that especially at low kV a lot of backscattered electrons are lost
in the central hole and cannot be detected. A solution for that is the aBSD detector.

Operating
Principle

On the surface of the specimen, some of the primary electrons are backscattered. The backscat-
tered electrons then move towards the silicon segments of the BSD detector. If the energy of the
backscattered electrons is high enough, then the electrons pass through the very thin dead layer
of the diode and create electron-hole pairs in the silicon segments.

In each individual segment, the charge separation due to the electron-hole pairs is measured as a
current, which is used as a signal for image generation. Only electrons that have a high enough
energy can create electron-hole pairs and can contribute to image generation. Electrons that have
a lower energy (e.g. secondary electrons) are not detected by the BSD detector.

The emission of backscattered electrons from a specimen is related to the atomic number of the
involved material: Elements with high atomic numbers generate more backscattered electrons (i.e.
the backscatter coefficient is higher). When imaging, regions that contain elements with higher
atomic numbers appear brighter. Regions that contain elements with lower atomic numbers ap-
pear darker.

Since the detector has a limited speed, it is recommended to use scan speed 6 or higher (slower),
especially at small magnifications. The lower the gain is, the faster is the detector.
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Fig. 22: Quad mode showing different contrast on different segments of the aBSD detector: Seg-
ment S1: Pure material contrast (top left), Segment S2: Material contrast and topography (top
right), Segments S3 to S6: Pure topography (bottom left). For comparison: Surface contrast seen
with the InLens SE detector (bottom right)

At small magnifications, the field of view is limited by the hole inside the aBSD detector:

Fig. 23: Central hole of the aBSD detector
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The central hole is laser cut. As a result of this process, there is some silicon that beads up in areas
near the hole, but this silicon is conducting. It is therefore not charging up and not disturbing
your image quality.

NOTICE

Risk of property damage: Short working distance
When inserted, the aBSD detector is positioned directly underneath the objective lens. The
lower edge of the detector is then located at a working distance of 1.5 mm. If you move the
specimen to a working distance below 1.5 mm, then you damage the aBSD detector.

4 Do not move the specimen to working distances below 2 mm.

4 Be careful when you tilt the specimen.

3.3.1.5 aSTEM Detector

Purpose The optional aSTEM (annular Scanning Transmission Electron Microscopy) detector consists of an
electron detector underneath an ultrathin specimen.

The aSTEM unit is equipped with diodes that are switched on or off in order to allow dark field
and bright field imaging.

1

2

3

Fig. 24: aSTEM detector

1 Incident electron beam (primary electrons)

2 Thin specimen

3 aSTEM detector

Info
Risk of malfunction: The diode segments are sensitive to the light that is used for illumination
in TV mode (infrared and white).

When you use a diode detector, always make sure that the TV illumination is switched off. If
the CCD Mode is set to Auto Detect, then the TV illumination is automatically switched off
when a diode detector is used.
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Operating
Principle

The aSTEM detector is a pneumatically retractable multi-mode detector with a 12-stub specimen
holder for bright-field and dark-field detection.

The diodes of the aSTEM detector collect transmitted electrons below the ultrathin specimen.

A special arrangement of the diodes allows a parallel detection of bright field (BF), oriented dark
field (ODF), annular dark field (ADF), and high angle annular dark field (HAADF). There are one
bright field segment (S1), two dark field segments (S2 and S3), one annular dark field segment
(S4), and one high angle annular dark field segment (S5).

Two different models are available:

§ The aSTEM4 allows detection of four channels in parallel.

§ The aSTEM1 only collects one signal at a time.

S1

S2 S3

S4

S5

S3 S2

Fig. 25: The aSTEM detector head and the arrangement of its diodes

Operating Modes

The most commonly used STEM modes are predefined and can be selected from the drop-down
menu in the STEM Control panel.

The diagram in the STEM Control panel displays details concerning the diode status and the diode
arrangement.

Each diode segment can have the following status:

§ On: The signal is added to the total signal

§ Inverted (Inv.): The signal is inverted and then added to the total signal

§ Off: The signal is not used

NOTICE

Risk of property damage: Motorized specimen stage
Risk of damaging the detector when operating the motorized specimen stage.

4 Retract the detector head completely after you have finished the work with the detector.
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3.3.1.6 CL Detector

Purpose The Cathodoluminescence (CL) detector is an inclined detector that allows efficient visible or ultra-
violet light collection. The CL detector is ideal for use in geology, mineralogy, and materials sci-
ence applications where it can help in internal structural examination of rocks, ceramics, and
semiconductors.

1

2

3

4
5

Fig. 26: Schematics of the CL detector

1 Preamplifier

2 Photomultiplier

3 Objective lens

4 Light guide with collector electrode

5 Specimen

Operating
Principle

The prerequisite for using this detector is that the specimen emits light when interacting with the
primary electron beam. Differences in crystal structure or the presence of impurities in a cathodo-
luminescent material result in variations in the energy gap between the filled valence bands and
the empty conduction bands, and consequently a change in the CL emission.

The light (photons) emitted by the specimen is collected by the CL detector and converted into a
signal for imaging.

The CL detector is fully integrated into the automatic brightness and contrast control of the micro-
scope and can be used simultaneously with any of the detectors without degrading their perfor-
mance.

The detector can be used during energy-dispersive X-ray spectrometer (EDS) measurements and
wavelength-dispersive spectrometer (WDS) measurements at any valid magnification.

Fig. 27: CL image of sandstone
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3.3.2 Control Panel

Purpose The control panel allows direct access to 14 of the most frequently used functions. It integrates a
full sized keyboard, 11 turning knobs, and 8 push buttons.

Position The control panel is placed on the work desk.

1 2 3

6 7 8

4 5

11109
Fig. 28: Control panel

1 Stigmator X | Stigmator Y

Shapes the beam roundness by changing the stigmation deflectors.

2 Aperture X | Aperture Y

Adjusts the mid column shift and tilt deflectors for aligning the beam along the column
axis.

3 Scan Rotate

Rotates the scanning pattern 360° continuously.

This turning knob has a push button function to deactivate the scan rotate function and
reset the scan rotation to 0°.

4 Shift X | Shift Y

Shifts the scanned region of the specimen in the X and Y directions.

5 Brightness | Contrast

§ Brightness

Adjusts the image acquisition chain offset for the currently selected detector. Each
configured detector stores its own brightness.

§ Contrast

Adjusts the gain of the currently selected detector.

6 Magnification | Reduced

§ Magnification

Adjusts the magnification of the system.

§ Reduced

Changes the scan field to a reduced area. The size of the area is determined by the
current sub scan area settings.
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7 Wobble

Sweeps the acceleration voltage. If the aperture is slightly misaligned, a shift in X and/or
Y direction can be observed.

8 Freeze

Stops the scan and grabs one complete frame at the current imaging conditions.

9 Exchange | Resume

§ Exchange

Starts the pre-defined macro for specimen exchange with the airlock.

§ Resume

Starts the pre-defined macro to finish specimen exchange with the airlock.

10 Camera

Switches to chamber view.

11 Focus | Scan Speed +/−

§ Focus

Changes the focal point of the column by adjusting the magnitude of the objective
lens.

§ Scan Speed +/−

Increases (+) or decreases (−) the scan speed by doubling or halving the beam dwell
time with each click step.
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4 Software Description

4.1 SmartSEM

4.1.1 SmartSEM User Interface

The SmartSEM software graphical user interface (GUI) allows you to monitor and operate most of
the active components of the microscope.

The following screenshot indicates the main elements of the SmartSEM user interface:

11

1 32 4 65

710 81213 9
Fig. 29: Screen layout of the user interface

1 Title Bar

Displays the name of the user interface and the
logged-on user.

2 Menu Bar

Enables you to access to SmartSEM features via
sub-menus.

3 AVI Toolbar

Contains the controls to set up, record, and play-
back video sequences of scanned images.

4 Toolbar

Provides quick access to SmartSEM tools.

5 Image Area with Data Zone

Displays image information and acquisition param-
eters from the microscope.

6 FIB Toolbar

Contains the controls to configure the FIB column.
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7 Thumbnails Panel

Displays thumbnail views of the contents of the
eight image buffers.

8 Status Bar

Displays the current machine state and contains
the SEM Control Buttons.

9 Data Zone

Displays image information and acquisition param-
eters from the microscope.

10 Annotation Bar

Enables you to add information to the SEM image
and provides several measurement functions.

11 Panel Configuration Bar

Enables you to choose the panels to be placed in
the Docking Panel.

12 Docking Panel

Enables you to arrange frequently used SmartSEM
panels for convenient access.

13 Mini Bar

Provides quick access to recently used dialogs and
to the recipe management.

4.1.2 Graphical Control Elements

The following graphical control elements are used in the SmartSEM GUI.

Screenshot Control El-
ement

Function

Tab Provides a group of graphical control elements.

Section Forms a group of control elements with related functions.

Button Enables you to start an action.

Checkbox Enables you to activate or deactivate a function.

Drop-down
list

Enables you to select the desired element.

Radio but-
ton

Enables you to activate the desired option.

Scroll bar Enables you to adjust a value by moving the scroll bar or pressing
the arrow button until the desired value is set.

Readout Displays the status of a system entity.

Enables you to select an action or a value by opening a dialog with
an input field.
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Screenshot Control El-
ement

Function

Input field Enables you to enter the desired value.

Progress
bar

Displays the progress of an action.

Slider Enables you to adjust the corresponding function.

Navigation
box

Provides visual indication of the range and current value of one-
and two-dimensional parameters such as Beam Shift or Stigmation.

4.1.3 User Access Levels and User Privileges

The user access level defines which parameters are displayed for selection purposes, e.g. in the
status window or annotation parameter selection.

SmartSEM distinguishes different user access levels. Depending on the user access level, different
parameters are accessible. User profiles are defined by the administrator.

Access: Menu Bar > Tools > Administrator

User Access Level Description

Novice Only the items assigned to the novice category are accessible. These
include most frequently used parameters.

Expert Items assigned to the novice and expert category are accessible.
These include parameters useful for advanced operators.

Service All items are accessible, also including infrequently used items and cal-
ibrations.

Additional to the user access levels there are user privileges which are part of the user profile:

Checkbox Privilege

Calibration Enables the user to perform instrument calibration operations.

Change Image Direc-
tory

Enables the user to change the location where all images are saved.

Change Toolbar Enables the user to change the toolbar.

Change User Direc-
tory

Enables the user to change the location where all user specific param-
eters and configurations are saved.

Extractor Enables the user to change the extractor voltage.
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Checkbox Privilege

FIB Probe Alignment Enables the user to adjust the probe currents.

Gun Align Enables the user to modify the alignment of the electron beam.

Gun Off Enables the user to switch off the field emission filament.

Mill Defaults Enables the user to modify the default settings for FIB milling.

Stage Initialise Enables the user to initialize the motorized stage.

Supervisor Enables the user to perform the following actions:

§ Start the Administrator, create and edit users

§ Set User Max EHT

§ Modify the filament current

§ Set up, edit, and delete global stage coordinates

§ Save common macros and toolbars

§ Save common recipes

§ Activate Partial Vent on Standby, Z Move on vent, Protect Z, Go
to HV@Shutdown, EHT Off & Log Off and Leave Gun ON at Shut-
down.

§ Use the bakeout function

§ Start the FIB filament heating.
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4.1.4 SmartSEM Program Suite

The SmartSEM Program Suite comprises the EM server, which implements the internal communi-
cation between control software and microscope hardware, plus several programs and utilities.

The main purpose of the SmartSEM Program Suite is to access all necessary microscopy parame-
ters and software features to capture SEM data and optimize image acquisition.

Access: Windows start menu > SmartSEM

Program Description

ChamberScope Enables you to display the chamberscope image and the detector im-
age at the same time.

Option, requires particular hardware.

FTP Image Archiving Enables you to transfer data via FTP.

License: REMARCH

ReadMe Contains important information on the currently installed version.

Release Notes Contains an overview of all SmartSEM versions including new devel-
opments and specific details.

RemCon32 Serial interface for remote operation via RS232, e.g. for EDX

License: REMCON

Sample Holder
Gallery

Enables you to inspect the dimensions of all possible specimen holders
as well as to set the dimensions of the custom specimen holders.

Enables you to activate the available specimen holders for SmartSEM.

SEM Drift Correction Enables you to compensate for the drift of the specimen by using a
reference image and by controlling the beam shift.

License: DRIFT-CORR

Slideshow speed set-
ting

Enables you to adjust the slideshow speed for the Windows Photo
Viewer.

SmartSEM Adminis-
trator

Enables you to manage user profiles and configure instruments.

SmartSEM User Ac-
counting

Enables you to record important information during individual work-
ing sessions, e.g. logon/logoff time, number of TIFF files exported etc.

SmartSEM User In-
terface

Main software application

Access: Windows start menu > SmartSEM Service

Program Description

Calibration Wizard Service activities, for ZEISS service representatives only

Gun Monitor Enables you to monitor important parameters of the microscope.

GUN Service Service activities, for ZEISS service representatives only

Piezo Configurator Service activities, for ZEISS service representatives only

Service Centre Provides an overview of the state of the microscope.

Smart Stage Map-
ping

Service activities, for ZEISS service representatives only
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Program Description

SmartBackup Tool Enables you to back up configuration and calibration data.

Stage Administrator Service activities, for ZEISS service representatives only

Upgrade Scangen
Firmware

Service activities, for ZEISS service representatives only

Upgrade Server
Database

Service activities, for ZEISS service representatives only

Merlin Alignment
Wizard

Service activities, for ZEISS service representatives only

Merlin Database
Wizard

Service activities, for ZEISS service representatives only
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4.2 SmartFIB

4.2.1 SmartFIB User Interface

 The following screenshot indicates the main elements of the SmartFIB user interface:

1 2 3 4

6 5

1 Menu Bar

The menus on the Menu Bar contain basic commands that you need to work with Smart-
FIB. The functionality depends on the selected mode.

2 Standard Toolbar

Contains various buttons for quickly accessing a subset of the commands contained in
the Menu Bar.

Additionally, there are various exclusive functions, such as previews and mode switching.

3 Working Area

In the Working Area, the following items are displayed:

§ Live Mode: captured image and patterning elements

Editing of patterning elements is possible only in Live Mode.

§ Sample Mode: Virtual Sample and writing positions

§ EPD Mode: captured image and thickness map

4 Control Panel

Contains tabs for controlling the FIB process. The range of visible tabs depends on the se-
lected mode.

5 Status Bar

§ Left hand side: informs you about the current mouse position in the Working Area
and indicates the selected tool, e.g. Vertex.

§ Right hand side: enables you to control some exclusive properties of the Working
Area.
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5 Tools Toolbar

Contains tools for the Working Area. The range of visible tools depends on the selected
mode.

4.2.2 Graphical Control Elements

The following graphical control elements are used in the SmartFIB GUI.

Screenshot Control Element Function

Tab Provides a group of graphical control elements.

Section Forms a group of control elements with related functions.

Button Enables you to start an action.

Checkbox Enables you to activate or deactivate a function.

Drop-down list Enables you to select the desired element.

Radio button Enables you to activate the desired option.

Scroll bar Enables you to adjust a value by moving the scroll bar or
pressing the arrow button until the desired value is set.

Readout § Displays the status of a system entity.

§ Enables you to select an action or a value by opening a
dialog with an input field.

Input field Enables you to enter the desired value .

Slider Enables you to adjust the corresponding function.

Expandable sec-
tion

Enables you to expand or collapse the section as required.
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4.2.3 SmartFIB Program Suite

The SmartFIB program suite comprises two main programs: SmartFIB and Designer (requires the li-
cense CREATOR). Each of these programs has a different field of use.

The main purpose of the SmartFIB program suite is to transfer geometric elements to a specimen
with the help of a particle beam. This process is referred to as "exposure".

Access: Windows Start Menu > Programs > SmartSEM

Program Description

SmartFIB § Main tool for online/live work on the microscope

§ Milling/etching/deposition of patterning elements

§ Provides the following modes:
– Live Mode: Mainly used for editing patterns and structures and

creating recipes
– Sample Mode: Mainly used for creating recurring/automated

workflows
– EPD Mode: Used for thickness determination of a TEM lamella

Designer § Offline creation of layouts: Arrangement of elements in the scan-
ning area

§ Interaction with Sample Mode: Used as a drawing tool for Sample
Mode
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5 Installation
Unpacking, installation, and first start-up are carried out by an authorized ZEISS service represen-
tative.

An excerpt of the installation requirements can be found under Installation Requirements [} 114].

For more details refer to the document Installation Requirements.
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6 Operation

6.1 Starting the System

6.1.1 Energizing the Microscope

 WARNING

Risk of injury: Restart after emergency off
If the reason for the emergency off is not eliminated, it may be dangerous to restart the micro-
scope.

4 If the microscope has been de-energized due to an emergency, ensure that the reason for
the emergency off does not exist anymore.

4 Make sure it is safe to energize the microscope.

Prerequisite ü The microscope has been de-energized by turning the MAIN switch to the OFF position.

ü Alternatively, the microscope has been de-energized by pressing the Emergency Off (EMO)
button.

1. Verify that the main shut-off valves for compressed air, nitrogen, and cooling water at the
facility installation are operable. 
Otherwise open and unlock the main shut-off valves.

2. If the Emergency Off (EMO) option is installed, pull the EMO button to release it.
3. Set the MAIN switch to the ON position.

4. If the Emergency Off (EMO) option is installed,
press the green S2 button to confirm the set-
ting of the MAIN switch.
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6.1.2 Starting the Microscope

Prerequisite ü The microscope is energized.

1. At the front of the plinth, press the ON button.
à The ON button blinks green while the system is activated.
à When all subsystems are fully activated, the

ON button lights up green permanently.

6.1.3 Starting SmartSEM

1. Power up the computer and log in.
2. Start the SmartSEM user interface via the ZEISS SmartSEM icon on the desktop.

Alternatively, select Windows start menu > SmartSEM > SmartSEM User Interface.
à The EM Server opens while loading various drivers. The EM Server implements the inter-

nal communication between software and hardware of the microscope.
à The EM Server Log On dialog is displayed.

3. Enter the user name and password.
4. Click OK.

à The SmartSEM user interface opens and is ready to operate the microscope.

6.1.3.1 Calling up the Help

There are different ways to access topics in the Online Help.

Function Menu Shortcut Control Elements

Startup page Help F1 –

Table of Contents Help > Contents Ctrl+F1 –

Context-sensitive – § Shift+F1

§ F1 on focus

Question mark icon
in the main window
and in modal dialogs

Detailed information about using the help system is given in the Online Help directly.

6.1.3.2 Keyboard Shortcuts

The following keys are shortcut keys and have special meaning.

Shortcut Function

<F2> Toggles Tool Bar on/off

<F2 + SHIFT> Hysteresis removal

<F3> Closes all windows except the Tool Bar and Status Bar

<F3 + SHIFT> Toggles PC Plane ON/OFF
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Shortcut Function

<F4> Step to next Magnification Table entry, or Undo Centre Feature Mag-
nification

<F4 + CTRL> Step to previous Magnification table entry

<F4 + SHIFT> Exit from Magnification Table mode

<F5>, <F5 +
SHIFT>
<F6>, <F6 +
SHIFT> 
<F7>, <F7 +
SHIFT>
<F8>, <F8 +
SHIFT>

User defined macros

<F9> Keys help (displays this information)

<F11>, <F11 +
SHIFT>

User defined macros

<F12>, <F12 +
SHIFT>

Aborts Stage Movement

<TAB> Toggle coarse/fine

<CTRL + TAB> Performs Centre Point

<CTRL + SHIFT +
TAB>

Performs Centre Feature

<HOME> Resets Beam Shift to zero

<SCROLL LOCK> Toggles Freeze/Unfreeze

<PAUSE> Causes currently executing macro to continue

<*> Performs Find Image function

<CTRL + 2> Loads Second Image Window from display

<CTRL + A> Switches Annotation panel ON

<CTRL + B> Display Toolbar View dialog

<CTRL + D> Toggle Data Zone ON/OFF

<CTRL + E> Calls the Export TIFF dialog

<CTRL + F> Starts Auto Focus fine

<CTRL + SHIFT +
F>

Starts Auto Focus coarse

<CTRL + G> Switches Crossbeam SEM Control Panel ON

<CTRL + I> Switches SEM Status Panel ON

<CTRL + M> Switches to Annotation and inserts Point to Point Marker

<CTRL + ALT + M> Enable/Disable the Movable Crosshairs Marker

<CTRL + ALT + F> Enable/Disable Mouse Following for Movable Crosshairs Marker
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Shortcut Function

<CTRL + O> Calls the Import TIFF dialog

<CTRL + P> Performs the Print Image function

<CTRL + S> Calls the Export TIFF dialog to save the image

<CTRL + ALT + S> Performs Auto Astigmatism Correction

<CTRL + SHIFT +
S>

Performs Auto Astigmatism Correction with Auto Focus

<CTRL + T> Calls Text Annotation

<CTRL + V> Displays the Vacuum status information

Keypad <+> Faster Scan

Keypad <-> Slower Scan

ARROW Keys See Use of ARROW Keys

Image Buffer keys See Image Buffer

<SHIFT> and dou-
ble click

Performs Centre Point function

6.2 Obtaining a First Image

Info
Mobile phones in the microscope room can cause image quality infringements and in worst
case workflow interruptions.

Purpose This section describes basic procedures to obtain an image using the SE detector. To simplify the
procedure, the description uses the Crossbeam SEM Control panel and status bar functions in the
SmartSEM software.

Overview The procedure contains the following steps:

§ Preparing the Specimen Holder [} 69]

§ Loading the Specimen Chamber [} 70]

§ Locating the Specimen [} 72]

§ Switching on the Gun [} 73]

§ Switching on the EHT [} 74]

§ Acquiring an Image [} 74]

§ Optimizing the Image [} 76]

§ Saving the Image [} 78]
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6.2.1 Preparing the Specimen Holder

Parts and Tools Designation Part no.

Allen key, 1.5 mm Delivered with the microscope

Stub Delivered with the microscope

Tweezers for specimen Delivered with the microscope

Specimen holder Delivered with the microscope

If necessary: carbon tape, conductive carbon,
adhesive metal tape, or similar

–

Appropriate specimen (with conducting prop-
erties, e.g. gold on carbon)

–

Lint-free gloves –

NOTICE

Risk of property damage: Contamination caused by fingerprints
Contamination caused by fingerprints can lead to vacuum deterioration or prolonged pumping
times.

4 Always wear lint-free gloves when touching the specimen, specimen holder, or stage.

1. To attach a specimen to the stub, use conduc-
tive carbon, adhesive metal tape, carbon tape,
or similar.
Ensure that the specimen area that you want to
analyze is in proper contact with the stub.

2. To insert the stub into the specimen holder, use
tweezers.

3. To fix the stub to the specimen holder, tighten
the location screw with the Allen key.

4. Note down which fix position is occupied by the specimen.
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6.2.2 Loading the Specimen Chamber

Purpose Info
If your microscope is equipped with the optional airlock, use the airlock for loading the speci-
men chamber. For more information refer to the respective instruction manual.

Overview The procedure contains the following steps:

§ Displaying the Crossbeam SEM Control Panel [} 70]

§ Driving the Stage to a Low Position [} 70]

§ Venting the Specimen Chamber [} 70]

§ Mounting the Specimen Holder [} 71]

§ Evacuating the Specimen Chamber [} 72]

6.2.2.1 Displaying the Crossbeam SEM Control Panel

Prerequisite ü The SmartSEM user interface is started.

1. From the Menu Bar, select Tools > Goto panel.
à The Panel Configuration Bar is displayed. It contains an alphabetical list of functions.

2. Double-right-click Crossbeam SEM Control.
à The Crossbeam SEM Control panel is added to the docking panel.

6.2.2.2 Driving the Stage to a Low Position

Prerequisite ü The stage is initialized.

1. In the Crossbeam SEM Control panel, select the Imaging tab.
2. In the Detector / Active Channel section, select TV from the Signal A drop-down list.

à The inside of the specimen chamber is visible in the Image Area.
3. In the Crossbeam SEM Control panel, select the Stage tab.
4. Activate the Track Z checkbox.

à The current working distance (WD) is displayed in the Data Zone.
5. If the Data Zone is deactivated, activate it via Menu Bar > View > Data Zone > Show

Data Zone.
6. Use the dual joystick to drive the specimen stage downwards to a low position. 

 NOTICE  Risk of property damage: Observe the stage movement via camera to
avoid crashing.

6.2.2.3 Venting the Specimen Chamber

1. In the Crossbeam SEM Control panel, select the Vacuum tab.
2. Click Vent.

à The Vent message box is displayed.
3. To start venting, click Yes.

à The specimen chamber is purged with gaseous nitrogen.
à If the Stage is not initialized, a system message is displayed. Refer to Initializing the Stage

[} 99].
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6.2.2.4 Mounting the Specimen Holder

Safety Information  WARNING

Suffocation hazard: Lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal-
ing nitrogen may cause unconsciousness.

4 During specimen exchange, keep the chamber door open as short as possible.

4 Do not inhale the air from within the specimen chamber.

4 Ensure that the area around the microscope is sufficiently vented.

4 If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of
mental alertness and/or muscular coordination, depression of sensations, emotional insta-
bility, fatigue) leave the room immediately and inform the facility’s safety officer.

 CAUTION

Risk of injury: Moving the specimen stage
Fingers can be trapped by the moving specimen stage.

4 Always close the chamber door before moving the specimen stage.

4 To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your
fingers.

 CAUTION

Risk of injury: Closing the chamber door
Fingers can be pinched when closing the chamber door.

4 Use the door handle to close the chamber door.

4 Ensure not to get your fingers caught in the chamber door gap.

NOTICE

Risk of property damage: Short working distance
When opening the chamber door, the microscope or specimen can be damaged if the speci-
men stage is at a short working distance. If a BSD detector is inserted, it can be damaged as
well.

4 Always move the specimen stage to a long working distance before opening the chamber
door.

NOTICE

Risk of property damage: Contamination caused by fingerprints
Contamination caused by fingerprints can lead to vacuum deterioration or prolonged pumping
times.

4 Always wear lint-free gloves when touching the specimen, specimen holder, or stage.

1. Carefully open the chamber door.
2. If a specimen holder is mounted onto the specimen stage, remove it by sliding it out of the

dovetail rails.
3. Mount the prepared specimen holder by sliding it into the dovetail rails.

Make sure that the dovetail is placed in the correct orientation so that the flat side of the
dovetail of the specimen holder is flush with the milled edge of the specimen stage.
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4. Carefully close the chamber door.
à The specimen holder and the specimen inside the chamber are visible in the Image

Area.

6.2.2.5 Evacuating the Specimen Chamber

1. In the Crossbeam SEM Control panel, select the Vacuum tab.
2. Click Pump.

à Several vacuum status messages display the current vacuum levels.
à As soon as the appropriate vacuum level is achieved, the vacuum status message Vac

Status = Ready is displayed.
This may take up to 5 minutes.

6.2.3 Locating the Specimen

Overview The procedure contains the following steps:

§ Positioning the Stub under the Electron Beam [} 72]

§ Moving the Specimen to the Proper Height [} 73]

6.2.3.1 Positioning the Stub under the Electron Beam

Safety Information NOTICE

Risk of property damage: Driving the stage
While the stage is driven manually, there is a risk of damaging the objective lens and/or the
specimen.

4 Ensure not to hit the objective lens while driving the stage.

4 Monitor the moving stage in TV mode.

4 To stop the moving stage immediately, press F12 or press the Break push button of the
dual joystick panel.

4 Manually lower the stage before you open the chamber door. Alternatively, activate the Z
move on Vent checkbox in the Stage tab of the Crossbeam SEM Control panel.

1. In the Stage Navigation Bar, select Stage Sideview from the upper drop-down list and Stage
Topview from the lower drop-down list.
INFO: To open the Stage Navigation Bar, navigate to View > Toolbars and activate Stage
Navigation Bar (for Widescreen users). Alternatively, you can access the Stage Navigation
Bar via Stage > Navigation.

2. Click Settings.
à The Stage Navigation Settings dialog is displayed.

3. In the Stage Navigation Settings dialog, click Show Holder Gallery.
à The Sample Holder Gallery dialog is displayed.

4. In the Sample Holder Gallery dialog, click the specimen holder you are using.
5. Activate the Is Available checkbox.
6. Close the Sample Holder Gallery dialog.
7. Close the Stage Navigation Settings dialog.
8. In the Stage Topview section of the Stage Navigation Bar, spot the stub with the specimen

you want to observe.
9. To drive the stub directly under the electron beam, double-click the stub.
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6.2.3.2 Moving the Specimen to the Proper Height

1. In the Stage Navigation Bar, drag the Zoom View slider to the right end, so that the
schematics are zoomed in.

2. In the Crossbeam SEM Control panel, select the Imaging tab.
3. In the Detector / Active Channel section, select USB TV1 from the Signal A drop-down list.

à The inside of the specimen chamber is visible in the Image Area.
4. Use the dual joystick to carefully move up the stage so that the stub you are using is in the

center of the upper schematic.
 NOTICE  Risk of property damage: Observe the camera image in order not to
crash into the pole piece.
à INFO: After loading the specimen, there is the possibility to use the Sample Type Selec-

tion Function to automatically set a number of key parameters. Refer to Using the Sam-
ple Type Selection Function.

6.2.4 Switching on the Gun

NOTICE

Risk of property damage: Schottky field emitter
If the Schottky field emitter is switched on and off too frequently or inappropriately, its lifetime
is reduced.

4 Avoid switching off the gun during the working week.

4 Use Standby mode for the weekend or a break of up to a week.

4 When using the Standby mode, activate the Partial Vent on Standby function.

Prerequisite ü The chamber and the gun head have been evacuated.

1. In the right part of the Status Bar, verify whether the gun is switched on or off.

à If  or  is displayed, the gun is already switched on and you can skip the fol-
lowing steps.

à If  is displayed, the gun is switched off. Follow the operating steps within this
chapter.

2. In the Crossbeam SEM Control panel, select the Vacuum tab.
3. Verify that the EHT Vac ready readout is EHT Vac ready = Yes.

If not, the correct vacuum is not achieved. Check if the Pump procedure has been com-
pleted.

4. In the right part of the Status Bar, click .
à The pop-up menu for vacuum, gun, and EHT activation is displayed.

5. Click Gun On.
à The gun runs up.
à This may take up to 5 minutes.
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6.2.5 Switching on the EHT

Purpose When you switch on the EHT, the gun starts emitting electrons.

Prerequisite ü The chamber and the gun head have been evacuated.

ü The gun has been switched on.

1. In the Crossbeam SEM Control panel, select the Control tab.
2. Double-click the EHT Target readout.

à The EHT Target window is displayed.
3. In the input field, enter 10 and click OK.

4. In the right part of the Status Bar, click .
à The pop-up menu for vacuum, gun, and EHT activation is displayed.

5. Click EHT On.
à The EHT runs up to 10 kV.
à In the right part of the Status Bar, the vacuum, gun, and EHT status buttons merge to

.

6.2.6 Acquiring an Image

Purpose Info
The following procedure describes the best way to quickly obtain an image without the con-
trol panel. You can also use the control panel to adjust aperture alignment, magnification/fo-
cus and brightness/contrast.

Overview The procedure contains the following steps:

§ Selecting the Column Mode and Probe Current [} 74]

§ Selecting the SE Detector [} 74]

§ Setting a Fast Scan Speed [} 75]

§ Setting a Low Magnification [} 75]

§ Setting a Long Working Distance [} 75]

§ Adjusting Brightness and Contrast [} 75]

§ Visualizing Details on the Specimen Surface [} 75]

6.2.6.1 Selecting the Column Mode and Probe Current

1. In the Crossbeam SEM Control panel, select the Control tab.
2. In the Column section, click Normal.

à The column mode is set to Normal.
3. In the Beam section, double-click the I Probe readout.

à The I Probe window is displayed.
4. In the input field, enter 300.

à The probe current is set to 300 pA.

6.2.6.2 Selecting the SE Detector

1. In the Crossbeam SEM Control panel, select the Imaging tab.
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2. In the Detector / Active Channel section, select Signal A = SE2 from the Signal A drop-
down list. 
INFO: We recommend using the SE detector to obtain the first image. This detector pro-
vides a good signal-to-noise ratio even at long working distances.

6.2.6.3 Setting a Fast Scan Speed

1. In the Crossbeam SEM Control panel, select the Imaging tab.
2. From the Scan Speed drop-down list, select Scan Speed = 1.

INFO: The lower the scan speed number, the faster the electron beam scans across the
specimen. Scan Speed = 1 allows you to get an image quickly.

6.2.6.4 Setting a Low Magnification

1. In the Toolbar, select the Magnification+Focus/Auto Focus+Stig icon.

à The Status Bar displays the values for magnification and focus.

2. In the Status Bar, click .
à The Mag window is displayed.

3. In the Mag input field, enter 500.
4. Click OK.

à The magnification is set to Mag = 500 x.

6.2.6.5 Setting a Long Working Distance

1. In the Status Bar, click .
à The WD window is displayed.

2. In the WD input field, enter 10.
3. Click OK.

à The working distance is set to WD = 10 mm.

6.2.6.6 Adjusting Brightness and Contrast

1. In the Crossbeam SEM Control panel, select the Imaging tab.
2. In the Detector / Active Channel section, use the scroll bars to adjust brightness and con-

trast.

6.2.6.7 Visualizing Details on the Specimen Surface

1. Select a detail on the specimen surface.
2. Verify the Magnification/Focus function is activated.

3. To adjust the magnification, hold down the left mouse button and drag the mouse within
the Image Area in left/right direction.
à The current magnification is indicated in the Status Bar.

4. To adjust the focus, change the working distance. Hold down the mouse wheel and drag
the mouse within the Image Area in left/right direction.
à The current working distance is indicated in the Status Bar.

5. Adjust contrast and brightness again.
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6.2.7 Optimizing the Image

Purpose Once you have generated an initial image, you can adjust various parameters to optimize the im-
age.

Info
The following procedure describes the best way to quickly optimize the image without the
control panel. You can also use the control panel to adjust aperture alignment, magnification/
focus and brightness/contrast.

Overview The procedure contains the following steps:

§ Adjusting the Magnification [} 76]

§ Moving the Field of View at High Magnifications [} 76]

§ Limiting the Scan Field [} 77]

§ Aligning the Aperture [} 77]

§ Selecting the Scan Speed [} 77]

§ Correcting Astigmatism [} 78]

6.2.7.1 Adjusting the Magnification

1. To switch to the Fine mode, in the Status Bar, click .

à The  button changes to .
2. Step by step, raise the magnification up to Mag 50,000 x and focus in between.

To adjust the magnification and the focus, hold down the left mouse button or the mouse
wheel, respectively, and drag the mouse within the Image Area.

6.2.7.2 Moving the Field of View at High Magnifications

Purpose If you want to move the field of view at high magnifications, use the Beam Shift function instead
of moving the stage.

1. In the Crossbeam SEM Control panel, select the Control tab.
2. In the Alignment section, click Beam Offset.
3. To shift the beam, in the Beam Offset naviga-

tion box, use the scroll bars or the red marker.
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6.2.7.3 Limiting the Scan Field

Prerequisite ü Adjusting the size and position of the small frame (reduced raster) requires the license RE-
DUCED.

1. In the Toolbar, click the Reduced Raster/Apertures icon.

à A small scan frame is displayed. This frame defines the specimen area to be scanned by
the electron beam.

à The image outside the scan frame is frozen.
2. To change the position of the scan frame, click on the green border line and use the mouse

to drag and drop the frame.
3. To change the size of the scan frame, click on the small blue squares on the green border

line and drag them to the desired size.
4. Focus the image in the reduced raster.

6.2.7.4 Aligning the Aperture

1. In the Crossbeam SEM Control panel, select the Control tab.
2. In the Alignment section, click Focus Wobble.

INFO: Focus wobble is a function that sweeps the acceleration voltage. If the aperture is
misaligned, a lateral and vertical shift can be observed.
à The Focus Wobble window is displayed.

3. To adjust the wobble intensity, use the Wobble Amplitude scroll bar.
4. To accelerate the wobble speed, activate the Wobble Fast checkbox.
5. In the Control tab, click Aperture.
6. In the Aperture Align navigation box, use the scroll bars or the red marker to adjust the

aperture alignment until there is no movement of the detail in X- and Y-direction.
INFO: The specimen detail should just be pulsating without shifting.

7. In the Focus Wobble window, click OFF to deactivate focus wobble.
à The Focus Wobble window closes.

8. Refocus the image.

6.2.7.5 Selecting the Scan Speed

1. In the Toolbar, from the Faster/Slower drop-down list, select Scan Speed = 7.

Alternatively, in the Crossbeam SEM Control panel, select the Imaging tab, and from the
Scan Speed drop-down list, select Scan Speed = 7.
à The scan speed is set to Scan Speed = 7.

2. Bring the image into focus.
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6.2.7.6 Correcting Astigmatism

1. Ensure that the Reduced Raster function is active.
2. Select a detail (e.g. a mark or an edge) on the specimen surface.

Ensure that the selected detail is in the raster. You can move the stage or shift the beam for
this purpose.

3. In the Crossbeam SEM Control panel, select the Control tab.
4. Click Stigmator.
5. In the Stigmation navigation box, use the scroll bars or the red marker to obtain the

sharpest possible image.
INFO: The specimen detail should just be pulsating without shifting.
INFO: To obtain optimum results, alternately correct focus and astigmatism.

6. To deactivate the reduced raster, in the Toolbar, click the Reduced Raster/Apertures icon.

6.2.8 Saving the Image

1. In the Toolbar, click the Freeze:Unfreeze/Scanning icon.

à A red dot at the right bottom of the Image Area indicates that the image is frozen.
2. From the Menu Bar, select File > Save Image.

à The Export TIFF dialog is displayed.

3. To change the save path, click Change Directory.
à A file explorer window is displayed.

4. To confirm the selected path, click Select Folder.
5. Enter the filename in the Filename input field.
6. Click Save <file name>.tif.
7. To continue imaging, click the Freeze:Unfreeze/Scanning icon.
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6.3 Modifying Gun Parameters

6.3.1 Selecting the Gun Mode

Purpose The microscope can operate in different gun modes:

§ Normal

§ Imaging

§ Analytic

Normal Gun Mode

In Normal gun mode, the temperature of the Schottky emitter (gun / filament) and the extraction
voltage are optimized for a long lifetime of the Schottky emitter. Normal gun mode is suitable for
most applications.

Imaging Gun Mode

In Imaging gun mode, the temperature of the Schottky emitter and the extraction voltage are re-
duced in comparison to the Normal gun mode. This leads to a reduction of the energy spread of
the primary electrons. Overall, the probe current in Imaging gun mode is about half the probe cur-
rent in Normal gun mode.

Imaging gun mode is especially useful at low kV or at high magnifications to reduce chromatic
aberration and to achieve a better resolution. Switching from Normal gun mode to Imaging gun
mode is useful for reducing the probe current without any need for beam adjustments.

Analytic Gun mode

In Analytic gun mode, the Schottky emitter runs at default temperature but the extraction voltage
is increased in comparison to the Normal gun mode. This leads to a higher probe current. Overall,
the probe current in Analytic gun mode is about twice the probe current in Normal gun mode.

The Analytic gun mode is especially useful for applications which require high intensities (e.g.
WDX).

Info
After switching the gun mode, you can immediately work with the selected gun mode. For ap-
plications, which require a high probe current stability, wait 24 hours until a stability of 0.2 %/
h is reached. It is recommended not to change the gun mode during quantitative specimen
analysis.

1. From the Menu Bar, select Tools > User Preferences.
à The User Preferences dialog is displayed.

2. Select User > Expert Gun Mode.
3. Click in the Value field and select Yes.
4. Close the User Preferences dialog.
5. In the Panel Configuration Bar, double-click Crossbeam SEM Control.
6. In the Crossbeam SEM Control panel, select the Control tab.
7. In the Beam section, click one of the following buttons:

To switch to Imaging gun mode, click Imaging.
To switch to Normal gun mode, click Normal.
To switch to Analytic gun mode, click Analytic.
INFO: For maximum probe current, also check the alignment of the gun.
INFO: If you use the Analytic gun mode, then the lifetime of the emitter is reduced.
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6.3.2 Setting the Probe Current

Purpose With the GEMINI II column, you can set a lower probe current to analyze surface details at a high
resolution or higher probe currents for analytical purposes, e.g. to analyze the material of the
specimen.

Info
The maximum achievable probe current depends on the currently selected EHT and the in-
stalled aperture configuration.

1. In the Crossbeam SEM Control panel, select the Control tab.
2. Double-click the I Probe readout.

à The I Probe window is displayed.
3. In the input field, enter the desired value.

6.3.3 Measuring the Probe Current

Purpose Measuring the probe current using the Faraday cup ensures that the current displayed in the soft-
ware equals the incident probe current. The Faraday cup consists of a strongly absorbing material
with a cavity covered by a small aperture. If the beam is focused in this cavity, no secondary elec-
trons and no backscattered electrons leave the Faraday cup.

Parts and Tools Designation Part no.

Faraday cup 348342-8055-000

1. Load the Faraday cup into the specimen chamber.
2. Evacuate the specimen chamber.
3. Switch on the gun.
4. Switch on the EHT.
5. From the Panel Configuration Bar, select Specimen Current Monitor.

à The Specimen Current Monitor window is displayed.
6. Activate the Stage Bias checkbox.

à This activates the touch alarm that helps to avoid collisions of the stage.
7. Move the stage to the position of the Faraday cup.
8. Acquire an image of the Faraday cup.
9. Activate the Spot checkbox.

à Green crosshairs are displayed on the image. The crosshairs indicate the position of the
beam spot.

10. Grab the crosshairs and move them into the hole of the Faraday cup.
à The probe current is measured continuously.
à The measured probe current is displayed in the Specimen I readout.
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6.3.4 Changing the Extractor Voltage

Purpose The Extractor voltage is preset by the factory or by the ZEISS service representative. Within certain
limits, the operator may carefully increase the extractor voltage in order to optimize the probe
current for particular applications.

Info
Use a Faraday cup to measure the probe current when changing the extractor voltage.

Info
The newly set extractor value is only valid for the current work session. After a restart of the
SmartSEM software, the microscope restores the nominal extractor voltage.

Info
Reducing the extractor voltage may impair the performance and resolution of the microscope.

§ Avoid reducing the extractor voltage.

§ If at all, reduce the extractor voltage only for a short time (1–2 h) and by maximum 500 V.

Prerequisite ü The user privilege Extractor is required to change the extractor voltage.

1. From the Menu Bar, select Beam > Gun Setup.
à The Gun Service dialog is displayed.

2. To increase the extractor voltage, double-click the Extractor V Target readout.
à The Extractor V Target window is displayed.

3. Enter a higher value.
4. Click OK.

6.4 Working with Different Aperture Configurations and Beam Modes

6.4.1 Determining the Installed Aperture Configuration | Gemini II Column

Purpose The achievable maximum probe current depends on the type of installed anode aperture. The
type of aperture installed on the microscope can be determined via SmartSEM.

For the Gemini II column, two different column configurations are available:

§ 40 nA high resolution configuration

Anode aperture diameter Probe current Typical application

55 μm* 10 pA to 40 nA High resolution

§ 100 nA high current configuration

Anode aperture diameter Probe current Typical application

90 μm* 10 pA to 100 nA Combined high resolution
and analytical investigations

* Calibration value: deviation of 10 % possible
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Info
If you wish to change the installed configuration of your microscope, contact your local ZEISS
service representative.

1. From the Menu Bar, select View > SEM Status.
à The SmartSEM Status dialog is displayed.

2. In the Select tab, click Anode Aperture Diameter.
3. Select the Display tab.

à The parameter Aperture Size is displayed.

6.4.2 Selecting the Column Mode

Purpose With the Gemini column, different column modes are available.

The Normal mode is the standard imaging and analytical mode with a high flexibility for different
applications. Overview mode provides a large field of view.

1. In the Crossbeam SEM Control panel, select the Control tab.
2. In the Column section, select between:

Normal and Overview
3. If required, adjust the Depth of Field slider.

6.5 Finding Appropriate Detector Settings

6.5.1 Selecting a Detector

You need to select an appropriate detector depending on the application and the pressure mode.
In addition to the standard SE detector, several optional detectors are available.

For information on special set-up procedures for the detectors, see:

§ Setting up the InLens SE Detector [} 83]

§ Setting up the SE Detector [} 83]

§ Setting up the SESI Detector [} 85]

§ Setting up the aBSD/BSD Detector [} 86]

§ Setting up the EsB Detector [} 84]

§ Setting up the aSTEM/STEM Detector [} 88]

§ Setting up the CL Detector [} 91]

1. Select the Imaging tab of the Crossbeam SEM Control panel.
2. Select the detector from the Signal A drop-

down list.
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6.5.2 Setting up the InLens SE Detector

Purpose The InLens SE detector collects the SE signal, acquiring mainly information about surface topogra-
phy.

Fig. 30: Silver nanoparticles embedded in zeolite, imaged at 1.5 kV.

The following settings are recommended for the InLens SE detector:

EHT Typical WD Recommended WD

20 V – 10 kV 0–5 mm Short working distances are preferable for
good detection efficiency

10 kV – 20 kV 2–5 mm

Info
Avoid strong specimen tilting for the InLens SE detector.

1. In the Crossbeam SEM Control panel, select the Imaging tab.
2. From the Signal A drop-down list, select InLens.
3. Adjust the EHT and the working distance (WD) according to the suggestions in the table in

order to optimize the image.

6.5.3 Setting up the SE Detector

Purpose The SE detector collects the SE signal, highlighting the topography of the specimen.

Fig. 31: An eledone tentacle

The following settings are recommended for the SE detector:
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EHT Typical WD Collector Voltage

500 V – 5 kV 2–8 mm § Adjustable from −250 V to +400 V

§ Standard applications: +300 V

At a high magnification, you can opti-
mize the image by varying the collector
voltage.

§ Pseudo-backscattered (BSE) image:
−250 V to −50 V

This produces a topogaphic image of the
sample with no material contrast.

5 kV – 30 kV min. 6 mm

1. In the Crossbeam SEM Control panel, select the Imaging tab.
2. From the Signal A drop-down list, select SE2.
3. Adjust the EHT, working distance (WD), and collector voltage according to the suggestions

in the table in order to optimize the image.

6.5.4 Setting up the EsB Detector

Purpose The EsB detector can be used to collect the backscattered electrons (BSE) signal. The BSE signal
contains information about the material contrast. In the final image, heavy elements are repre-
sented by brighter pixels and light elements are represented by darker pixels.

By adjusting the filtering grid, energy-selected BSE images can be obtained. If the filtering grid
voltage is set to 0, SE and BSE mixed images can be acquired.

Fig. 32: Silver nanoparticles embedded in zeolite, imaged at 1.5 kV

The following settings are recommended for the EsB detector:

EHT Typical WD Filtering Grid

500 V – 10 kV 0–5 mm EsB Grid > 400 V to filter out the SE signal

20 V – 500 V 0–3 mm EsB Grid = 0 V for use as an additional SE de-
tector

1. In the Crossbeam SEM Control panel, select the Imaging tab.
2. From the Signal A drop-down list, select ESB.
3. Adjust the EHT, working distance (WD), and EsB Grid according to the suggestions in the

table in order to optimize the image.
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6.5.5 Setting up the SESI Detector

Purpose The SESI detector is optionally available and replaces the chamber SE detector.

The SESI detector enables you to acquire both secondary electron images and FIB secondary ion
images.

Fig. 33: Intergranular corrosion in an nickel based superalloy

The following settings are recommended for the SESI detector:

§ Settings when working in SE mode, secondary electron imaging, FIB mode = SEM:

EHT Typical WD Collector Voltage

100 V – 30 kV 2–12 mm

Typically 5 mm

§ Adjustable from 0 V to +1500 V

§ Best detection: +300 V to +400 V

§ Settings when working in SE mode, secondary electron imaging, FIB mode = FIB:

EHT Typical WD Collector Voltage

2 kV – 30 kV Coincidence point § Adjustable from 0 V to +1500 V

§ Best detection: +300 V to +400 V

§ Settings when working in ion mode, secondary ions imaging, FIB mode = FIB:

EHT Typical WD Collector Voltage

2 kV – 30 kV Coincidence point § Adjustable from −4 kV to +0 kV

§ Best detection: Around −4 kV

1. In the FIB Toolbar, from the Imaging Mode drop-down list, select an imaging mode, e.g.
FIB mode = SEM.

2. In the Crossbeam SEM Control panel, select the Imaging tab.
3. From the Signal A drop-down list, select SESI.

à By default, secondary electrons are detected.
4. In order to detect secondary ions, in the Imaging tab, activate the SESI Mode checkbox.
5. Adjust the EHT, working distance (WD), and collector voltage according to the suggestions

in the table in order to optimize the image.
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6.5.6 Setting up the aBSD/BSD Detector

Purpose The aBSD detector is a pneumatically retractable backscattered electron detector which is inserted
below the objective lens and is used for high efficiency and angle selective (aBSD) material charac-
terization.

Fig. 34: Quad mode showing different contrast on different segments of the aBSD detector: Seg-
ment S1: Pure material contrast (top left), Segment S2: Material contrast and topography (top
right), Segments S3 to S6: Pure topography (bottom left). For comparison: Surface contrast seen
with the InLens SE detector (bottom right)

The following settings are recommended for the aBSD detector:

EHT Typical WD Detector Settings

0.5–30 kV 5–12 mm Compositional mode for obtaining an image
that is high in atomic number contrast

Use topographic mode for showing surface
details

Use individual settings for channeling con-
trast

Make use of different concentric rings of the
aBSD detector to get angular resolved BSE
images

Use high or very high detector gain for low
accelerating voltage and/or low beam current

The EHT should be bigger than 2 kV to
achieve a significant detection efficiency.

1. From the Panel Configuration Bar, select BSD Control.
The BSD Control panel enables you to change the polarity of the segments, select BSD
modes, and set the BSD gain.
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à The BSD Control panel is displayed.

2. In the BSD Control panel, click BSD in to insert the aBSD detector.
à The stage is lowered by 20 mm to give space for the detector to be inserted.
à The detector is inserted.

3. In the Crossbeam SEM Control panel, select the Imaging tab.
4. From the Signal A drop-down list, select aBSD1 or aBSD4 A depending on your detector

type and configuration.
INFO: A refers to the video channel. B, C, and D are also available if you have the four-
channel version.

5. Adjust the EHT and the working distance (WD) according to the suggestions in the table in
order to optimize the image.

6. In the BSD Control panel, click a quadrant symbol to toggle its status between on (white),
inverted (black), and off (gray).

7. To choose the respective mode, click BSD: COMPO or BSD: TOPO.
The default setting for BSD is BSD: COMPO. All six segments (S1–S6, aBSD) or four seg-
ments (S1–S4, BSD) are set to on and an image that is high in atomic number contrast is
obtained.
The default mode for BSD: TOPO is S3 on, S4 on, S5 inv and S6 inv (aBSD) and S1 on, S2
on, S3 inv and S4 inv (BSD).

8. If you want to change the default setting to BSD: TOPO, click BSD: Set TOPO.
9. From the BSD Gain drop-down list, select Low, Medium, High, or Very High.

INFO: Since the detector has a limited speed, it is recommended to use scan speed 6 or
higher (slower), especially at small magnifications. The lower the gain is, the faster is the
detector.
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6.5.7 Setting up the aSTEM/STEM Detector

Purpose The aSTEM/STEM detector is used for compositional imaging or topographical imaging of ultra-
thin specimens. The aSTEM/STEM detector is available either with one video output channel
(aSTEM1) or with four video output channels (aSTEM4). The aSTEM detector is optionally avail-
able.

The aSTEM/STEM detector is equipped with several separate diode segments. The signals of the
segments can individually be added to or subtracted from the output signal in order to allow dif-
ferent STEM imaging modes, e.g. bright field (BF) or oriented dark field (ODF). The most com-
monly used STEM imaging modes are predefined and can be selected from a drop-down menu in
the STEM Control panel.

Fig. 35: Asbestos, oriented darkfield (ODF) image captured with an aSTEM4 detector (left), ODF
image showing real information about bending and lattice defects within each fiber (right).

STEM Control STEM imaging
mode

Output signal

BF S1

DF S2 + S3

ODF S2 - S3

ODF90° S3 - S2

ODF + BF S1 + S2 - S3

ODF90° + BF S1 - S2 + S3

BF + DF All on

User defined name Custom combination
of segments

Active segments
with +/- signs

Custom combination
of segments.

"+" on, "-" inverted
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STEM Control STEM imaging
mode

Output signal

BF S1

DF S2 + S3

ODF S2 - S3

ODF90° S3 - S2

ODF + BF S1 + S2 - S3

ODF90° + BF S1 - S2 + S3

BF + DF S1 + S2 + S3

ADF S2 + S3 + S4

HAADF Middle S4

HAADF outer S5

HAADF S4 + S5

User defined name Custom combination
of segments

Active segments
with +/- signs

Custom combination
of segments.
"+" on, "-" inverted
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STEM Control STEM imaging
mode

Output signal

Off -

BF S1

ADF S2 + S3 + S4 + S5

ODF 0° S2 - S3 + S4 - S5

ODF 90° S3 - S2 - S4 + S5

HAADF S6

ADF + HAADF S2 + S3 + S4 + S5 +
S6

DF 0° S2

DF 90° S3

DF 180° S4

DF 270° S5

User defined name Custom combination
of segments

Active segments
with +/- signs

Custom combination
of segments.
"+" on, "-" inverted

1. In the Crossbeam SEM Control panel, select the Imaging tab.
2. For displaying several channels of a aSTEM/STEM detector simultaneously, from the Menu

Bar, select Scanning > Quad Mode.
à The Image Area is divided into 4 zones.

To select a detector for a zone, click in the zone.
An anchor symbol is displayed in the selected zone.

3. From the Signal A drop-down list, select a STEM detector, e.g. aSTEM1.
4. In the Panel Configuration Bar, double-click STEM Control.

To open the Panel Configuration Bar, from the Menu Bar, select Tools > Goto Panel.
à The STEM Control dialog is displayed.

In the upper section, the STEM Control dialog displays the status of the diode segments.
The status is either on (white), inverted (black), or off (gray).

5. Either select a STEM imaging mode from the STEM Seg. Mode/STEM 6 Seg. Mode drop-
down list or click a custom selection of diode segments to toggle its status between on, in-
verted, and off.

6. Set the Gain range.
Select between Low, Medium, High, or Very High.

7. For displaying several channels of a aSTEM/STEM detector simultaneously, repeat steps 3 to
6 for the other display zones.
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6.5.8 Setting up the CL Detector

Purpose The CL detector is optionally available.

The CL detector collects visible or ultraviolet light and is especially useful for internal structural ex-
aminations of rocks, ceramics, and semiconductors.

Fig. 36: Zircon grains

The following settings are recommended for the CL detector:

EHT Typical WD

5 kV – 30 kV 6–10 mm

(min. 4 mm)

1. In the Crossbeam SEM Control panel, select the Imaging tab.
2. From the Signal A drop-down list, select CL.
3. Adjust the EHT and the working distance (WD) according to the suggestions in the table in

order to optimize the image.

6.6 Shutting down the System

6.6.1 Finishing the Work Session

NOTICE

Risk of property damage: Schottky field emitter
If the Schottky field emitter is switched on and off too frequently or inappropriately, its lifetime
is reduced.

4 Avoid switching off the gun during the working week.

4 Use Standby mode for the weekend or a break of up to a week.

4 When using the Standby mode, activate the Partial Vent on Standby function.

Prerequisite ü The microscope is in ON mode.

1. In the Crossbeam SEM Control panel, select the Gun tab.
2. Activate the EHT Off @ Log Off checkbox.
3. Activate the Leave Gun On at Shutdown checkbox.
4. Only when interrupting work for longer periods between 2 and 7 days: In the Vacuum tab

activate the Partial Vent on Standby checkbox.
à This maintains the gun vacuum, and switches off and protects the turbo pump.
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5. Exit the SmartSEM user interface. Refer to Exiting the SmartSEM User Interface [} 92].
6. Close all programs and software.
7. Select Windows start button > Power icon > Shut down.
8. At the front of the plinth, press the Standby button.

à The microscope switches to Standby mode.

6.6.1.1 Exiting the SmartSEM User Interface

1. From the Menu Bar, select File > Exit.
à A system message is displayed.

2. Click Yes.
3. Close the EM Server.

à A system message is displayed.
4. Click Yes.

6.6.2 De-energizing the Microscope

Prerequisite ü The microscope is in Standby mode, see Finishing the Work Session [} 91]

1. To switch to Off mode, press the Off button at the front of the plinth.
à The yellow Standby button blinks during shut down.
à When all subsystems are fully deactivated, the Off button lights up red permanently.
à Computer, electronic components, and vacuum system are switched off.
à The electron optical column is partially vented.
à A 24 V auxiliary voltage is still present to restart the microscope.

2. To cut off the compressed air supply, close the compressed air main shut-off valve.
3. To cut off the nitrogen supply, close the nitrogen main shut-off valve.
4. To cut off the cooling water supply, close the main shut-off valve for water.
5. Set the MAIN switch to the Off position.

à All power is cut off from the microscope.
6. To disconnect the power connection at the facility installation, remove the power plug

(male connector) from the socket (female connector).
7. To secure the microscope against accidental re-activation, refer to Performing a Lockout/

Tagout [} 93].

See also

2 Finishing the Work Session [} 91]

2 Performing a Lockout/Tagout [} 93]
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6.6.3 Performing a Lockout/Tagout

The Lockout/Tagout (LOTO) procedure defines the process by which the microscope is isolated
from potential hazards associated with the unexpected release of hazardous energy. This proce-
dure needs to be performed when service, maintenance work, or unscheduled repairs can cause
exposure to any form of hazardous energy.

Info
The customer is responsible for providing instructions on how to operate the energy-isolating
devices properly.

Prerequisite ü The microscope has been de-energized.

1. Verify that the microscope has been de-energized properly.
2. To secure the microscope against accidental re-activation, lock the energy-isolating devices.

6.7 Performing an Emergency Shutdown

NOTICE

Risk of property damage: Components in the high voltage circuitry
When the microscope, especially the gun, is fully on, an abrupt shutdown of all electrical sup-
plies may damage some components in the high voltage circuitry, mainly the cathode.

4 Use the emergency off only in an emergency situation with personnel injury.

1. Depending on whether the EMO option is installed on your microscope or not, operate the
respective control element.
If the EMO option is installed, press the EMO button on the top of the plinth.
If the EMO option is not installed, set the MAIN switch at the rear side of the plinth to the
OFF position.
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7 Maintenance and Repair

7.1 Maintenance Work

The preventive maintenance is performed by the ZEISS service representative and includes the fol-
lowing items:

§ Inspection

§ Preventive maintenance work

§ Change of consumables and chemicals

§ Equipment test

§ Verification run

Info
The maintenance work is accomplished according to standardized maintenance plans and is
recorded by the ZEISS service representative.

7.2 Maintenance Intervals

The maintenance intervals depend on the period of application of the device:

§ 24 hours, 7 days a week: semiannually

§ 8 hours, 5 days a week: annually

Info
Keep track of maintenance work and contact the ZEISS service representative in time.

A list of ZEISS locations and authorized service partners can be found at:

http://www.zeiss.com/microscopy

7.3 Change of Consumables and Chemicals

The change of consumables and chemicals has to be performed by a ZEISS service representative
at mandatory intervals.

The times scheduled are designed for the maximum equipment performance level (i.e. 24 h per
day of permanent operation).

Interval Component/Part

Every 6000 h1

(filament on)

Field emission gun (filament)1

Yearly or as required

(and after exchange of field emission gun)

§ Multihole/singlehole aperture

§ Anode aperture

§ Extractor aperture

§ Anode aluminum seal

§ Copper seal at gun head

Yearly or as required Tip seal of the pre-vacuum pump

Yearly performance check § SE detector

§ InLens SE detector
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Interval Component/Part

§ EsB detector

As required, approx. 3000 µAh § Ion source

§ FIB apertures

If used up Precursors

1 There is no warranty on field emission guns; manufacturers do not guarantee any lifetime.

Tab. 3: Schedule for the change of consumables
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8 Troubleshooting

8.1 Overview

The following table provides hints for solving common problems. If you cannot solve the problem
or if you are unsure about a certain technical difficulty, contact your local ZEISS service represen-
tative.

Keyword Symptom Cause Remedy

Drift Specimen seems to be
moving.

§ Charging effects.

§ Nonconductive speci-
men.

§ Ensure proper conduc-
tion of the specimen.

§ Optimize specimen
preparation.

§ Apply a charge com-
pensation method.

Stub not correctly fixed by
screw.

Fix the stub correctly.

EHT EHT cannot be switched
on.

CAN communication has
failed.

Refer to Checking the CAN
Communication [} 99].

The workstation has
crashed.

CAN communication has
failed.

Refer to Checking the CAN
Communication [} 99].

FIB Emission is unstable. Ion source needs to be re-
generated.

Refer to Regenerating the
Ion Source by Heating
[} 106].

Ion source may be used up
( > 3000 μAh).

Contact the ZEISS service
representative to have the
ion source replaced.

FIB No emission. Ion source needs to be re-
generated.

Refer to Regenerating the
Ion Source by Heating
[} 106].

Ion source may be used
up.

Contact the ZEISS service
representative to have the
ion source replaced.

FIB No image. Aperture position is not
correct.

Initialize the FIB aperture in
the FIB tab of the FIB Con-
trol panel.

Align the aperture in the
Align tab of the FIB Con-
trol panel.

Column conditions have
deteriorated, charging ef-
fects occur.

Start a purging process in
the Options tab of the FIB
Control panel.

Gun valve is closed. Open the gun valve in the
FIB tab of the FIB Control
panel.

FIB Emission current is too
high (e.g. 4 or 5 μA) for
more than 30 min.

Ion source needs to be re-
generated.

Refer to Regenerating the
Ion Source by Heating
[} 106].
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Keyword Symptom Cause Remedy

Automatic regulation of
the emission current is de-
activated.

Activate the Regulate
checkbox in the FIB tab of
the FIB Control panel.

Extractor target is not set
to an appropriate value.

Change the extractor tar-
get. Refer to Manually
Finding a New Extractor
Value [} 107].

Open the Gun Monitor
and record the parameters
FIB Suppressor Target
and FIB Emission I and
send it to your ZEISS service
representative.

FIB Suppressor voltage is ap-
proaching 0 V or 2 kV.

Ion source needs to be re-
generated.

Refer to Regenerating the
Ion Source by Heating
[} 106].

FIB Misalignment of struc-
tures when milling with
different FIB probe cur-
rents.

Beam shift for the probe
currents is not adjusted.

Adjust the beam shift cor-
rection for the relevant FIB
probe currents.

Image quality Image quality gets worse,
but there is no change in
total emission current.

Field emission gun has
been damaged due to arc-
ing.

Contact your local ZEISS
service representative to
have the field emission gun
replaced.

Image is noisy and noise
reduction methods do not
help.

Field emission gun is used
up.

Contact your local ZEISS
service representative to
have the field emission gun
replaced.

Image is bad at low EHT
(e.g. 1 kV)

Working distance is too
long.

Reduce the working dis-
tance to a maximum of
7 mm.

InLens image InLens image is noisy. Working distance is too
long.

Reduce the working dis-
tance.

No InLens image can be
obtained.

EHT exceeds 20 kV. Reduce EHT to a maximum
of 20 kV.

Microscope Microscope is dead. Circuit breaker is tripped
(lower position).

Refer to Checking the Posi-
tion of the Circuit Breakers
[} 104].

PC Stored position of the
specimen stage cannot be
approached correctly.

PC has crashed. Restart the PC.

Stage needs to be driven
to a well-defined position.

Refer to Initializing the
Stage [} 99].

SEM Gun Gun is switched off auto-
matically.

Gun has been switched off
automatically for safety
reasons since gun vacuum
is worse than
2 × 10⁻⁸ mbar

Refer to Baking out the
Gun Head [} 102].
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Keyword Symptom Cause Remedy

SE image SE image is noisy. Scintillator is used up. Contact your local ZEISS
service representative to
have the scintillator re-
placed.

Specimen current Specimen current is low. Field emission gun is used
up.

Contact your local ZEISS
service representative to
have the field emission gun
replaced.

Working distance is too
short.

Enlarge working distance
to about 5 mm or more.

Specimen stage Stage does not move. Stage needs to be initial-
ized.

Refer to Initializing the
Stage [} 99].

Stage does not move ac-
curately.

Stage needs to be initial-
ized.

Refer to Initializing the
Stage [} 99].

Stored position of the
specimen stage cannot be
approached correctly.

Absolute stage movement
is required. Stage needs to
be driven to a well-defined
position.

Refer to Initializing the
Stage [} 99].

Stage/Joystick Under TV control, the di-
rection of dual joystick
movement and direction
of stage movement seem
to be different.

TV joystick angle does not
fit for the selected CCD
camera.

Refer to Changing the Joy-
stick TV Angle [} 100].

Stage cannot be moved
by using the joystick.

Joystick Disable checkbox
is activated.

Deactivate the checkbox in
the Stage tab of the Cross-
beam SEM Control panel.

Temperature, water
flow

Error message Stage
Board too hot (or simi-
lar) is displayed.

Flow of cooling water is
not OK.

Refer to Checking the Wa-
ter Flow and Temperature
[} 102].

Touch alarm Touch alarm message is
displayed.

Specimen or specimen
holder has touched objec-
tive or wall of the speci-
men chamber.

Refer to Resetting the
Touch Alarm [} 101].

Vacuum Vac ready = OK is not dis-
played after specimen ex-
change.

System vacuum is bad due
to a vacuum leak at the
chamber door.

Check the chamber door
seal for cleanliness.

If required, refer to Replac-
ing the Chamber Door Seal
[} 101].

Vac ready = OK is dis-
played very late after
specimen exchange.

Gas ballast at rotary pump
or scroll pump is activated.

Deactivate gas ballast at
the pre-vacuum pump.

Microscope does not
vent.

No nitrogen. Check nitrogen supply.

No compressed air. Check compressed air sup-
ply.

Vac ready = OK is dis-
played abnormally fast.

Penning gauge has not
been identified correctly.

Restart the microscope.
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Keyword Symptom Cause Remedy

If this does not solve the
problem, contact your local
ZEISS service representa-
tive.

Gun vacuum is worse
than 8 to 9 × 10⁻⁹ mbar.

The pumping capacity of
the ion getter pump de-
creases in the course of
time, thus deteriorating
the gun vacuum.

Refer to Baking out the
Gun Head [} 102].

Optional Components

Keyword Symptom Cause Remedy

Flood Gun No communication can be
established with Smart-
SEM

Loose cable connection. Check the cable connec-
tion. If this does not help,
contact the ZEISS service
representative.

Flood Gun controller has
an old firmware version.

Flood Gun is not activated
in FIB Configurator.

8.2 Overall System

8.2.1 Checking the CAN Communication

Purpose Checking the CAN Communication is useful if the microscope does not react to your commands
anymore.

1. In the Panel Configuration Bar, double-click CAN Communication.
à The CAN Communication window is displayed.

2. If any of the values is indicated as Yes, make sure that all cable connections between work-
station and PC are plugged in correctly.

3. If this does not help, reset the workstation as described in the instruction manual of the mi-
croscope.
INFO: If the problem persists, contact your ZEISS service representative.

8.3 Chamber

8.3.1 Initializing the Stage

Purpose If a stored stage position cannot be approached or if the stage does not move or does not move
accurately, the stage needs to be initialized.

Prerequisite ü The specimen chamber has been evacuated, see Loading the Specimen Chamber [} 70]

ü Requires the Stage Initialise privilege

ü If there are any large specimens inside the chamber, remove them before initializing

1. From the Menu Bar, select Stage > Stage Initialise.
à The Initialise Stage window is displayed.

2. Confirm via Yes.
à The stage initialization process takes a few minutes.
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à INFO: If initialization of the stage does not solve the stage problem, contact your local
ZEISS service representative.

8.3.2 Defining the Post Initialization Position of the Stage

Purpose You can configure the position to which the stage drives after the initialization procedure. Other-
wise, the stage drives to the center position.

Prerequisite ü Requires the Supervisor privilege.

1. From the Windows start menu, select SmartSEM > SmartSEM Administrator.
à The SmartSEM Administrator Log on window is displayed.

2. Enter user name and password.
3. To confirm, click OK.

à The SmartSEM Administrator window is displayed showing the user list.
4. Click Column/Stage.
5. In the Stage Post Initialisation Position input fields, enter the desired position.

Alternatively, use the dual joystick to navigate to the desired position and click Set to cur-
rent position.

6. To activate the function, activate the Post Init. Posn Valid checkbox.

8.3.3 Changing the Joystick TV Angle

Purpose In TV mode (chamberscope), it can occur that dual joystick and stage seem to move to opposite
directions. This is because the selected CCD camera is installed at a certain angle relative to the
stage. Thus, the camera shows a side-inverted view. To remedy this, you need to change the joy-
stick TV angle setting in the software.

Info
If you are working with two CCD cameras: The joystick TV angle can only be set for one CCD
camera. When selecting the other CCD camera, you have to change the setting.

Prerequisite ü Requires the Supervisor privilege.

1. From the Windows start menu, select SmartSEM > SmartSEM Administrator.
à The SmartSEM Administrator Log on window is displayed.

2. Enter user name and password.
3. To confirm, click OK.
4. The SmartSEM Administrator window is displayed showing the user list.
5. Click Column/Stage.
6. In the Stage Options section, double-click the Joystick TV Angle input field.
7. Enter an angle depending on the installation lo-

cation of the CCD camera.
If the CCD camera is installed at the back, enter
180°.
If the CCD camera is installed at the front, enter
0°.
If the CCD camera is installed at the side, enter
90°.

180°

0°

90°

chamber door
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8.3.4 Replacing the Chamber Door Seal

Purpose Possible reasons for replacing the chamber door seal are the following:

§ Chamber door does not close tightly

§ Bad chamber vacuum

Overview The procedure contains the following steps:

§ Venting the Specimen Chamber [} 70]

§ Replacing the O-ring [} 101]

§ Evacuating the Specimen Chamber [} 72]

8.3.4.1 Replacing the O-ring

 WARNING

Suffocation hazard: Lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal-
ing nitrogen may cause unconsciousness.

4 During specimen exchange, keep the chamber door open as short as possible.

4 Do not inhale the air from within the specimen chamber.

4 Ensure that the area around the microscope is sufficiently vented.

4 If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of
mental alertness and/or muscular coordination, depression of sensations, emotional insta-
bility, fatigue) leave the room immediately and inform the facility’s safety officer.

NOTICE

Risk of property damage: Contamination caused by fingerprints
Contamination caused by fingerprints can lead to vacuum deterioration or prolonged pumping
times.

4 Always wear lint-free gloves when touching the specimen, specimen holder, or stage.

1. Carefully open the chamber door.
2. On the inside of the chamber door, remove the chamber door O-ring.

 NOTICE  Risk of property damage: If you use a metal tool to remove the O-ring,
then you may damage the sealing surface. If necessary, then only use a plastic or
wooden tool to remove the O-ring.

3. Inspect the groove that holds the O-ring and remove any contamination.
4. Insert the new chamber door O-ring.
5. Close the chamber door.

8.3.5 Resetting the Touch Alarm

Purpose To prevent damage, a touch alarm is integrated in the microscope. If the specimen or the speci-
men holder touches the chamber walls, the detectors, or the objective lens, the stage is stopped
immediately. An audible warning sounds and an on-screen message is displayed.

Prerequisite ü The EM Server shows the message WARNING Stage Touching.

1. To accept the warning, click OK.
2. Move the stage in the reverse direction away from the touch.
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8.3.6 Checking the Water Flow and Temperature

1. In the Panel Configuration Bar, double-click Water Flow/Temperature.
à The Water Flow/Temperature panel is displayed.

2. Check the entries.
à If a value is critical, it is displayed in red.

8.4 Column

8.4.1 Baking out the Gun Head

Purpose The pumping capacity of the ion getter pump decreases in the course of time, thus deteriorating
the gun vacuum. This can be remedied by an ion getter pump bakeout as a regular maintenance
procedure.

Overview The procedure contains the following steps:

§ Switching off the Gun [} 102]

§ Starting the Bakeout [} 103]

§ Switching on the Gun [} 73]

8.4.1.1 Switching off the Gun

Safety Information NOTICE

Risk of property damage: Schottky field emitter
If the Schottky field emitter is switched on and off too frequently or inappropriately, its lifetime
is reduced.

4 Avoid switching off the gun during the working week.

4 Use Standby mode for the weekend or a break of up to a week.

4 When using the Standby mode, activate the Partial Vent on Standby function.

1. In the right part of the Status Bar, click  or .
à The pop-up menu for Vacuum, Gun and EHT activation is displayed.

2. Click Shutdown Gun.
3. Wait until the gun has ramped down.

à This may take up to 5 minutes.
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8.4.1.2 Starting the Bakeout

Info
You cannot work with the microscope while the bakeout procedure runs.

Safety Information NOTICE

Risk of property damage: Hot surfaces during bakeout
Parts of the enclosure in the upper range of the column may become hot during bakeout, par-
ticularly after a long bakeout cycle.

4 Do not place any objects on the grids of the electron column during bakeout.

4 After the bakeout procedure, let surfaces cool down before working around the column.

4 Only advanced operators are allowed to perform the bakeout procedure.

Prerequisite ü Requires the Supervisor privilege and the user level Service

ü Only advanced operators are allowed to perform the bakeout procedure

1. In the Panel Configuration Bar, double-click Bakeout.
à The Bakeout dialog is displayed.

2. If the Full service bakeout checkbox is available, deactivate the Full service bakeout
checkbox.
INFO: Full service bakeout includes column heating that may lead to column misalignment.

3. From the Bakeout drop-down list, select a bakeout cycle.
For 2 hours heating / 1.5 hours cooling, select Quick.
For 8 hours heating / 1.5 hours cooling, select Overnight.
For 43 hours heating / 7 hours cooling, select Weekend.
For a cycle defined by the operator, select User.

4. To start the bakeout procedure, click Bakeout Start.

8.4.2 Calibrating the Probe Current

Purpose This function enables you to automatically calibrate the probe currents within a few minutes.

Calibrating the probe current can be necessary in the following cases:

§ Before performing analytical applications (e.g. EDX, WDX)

§ After changing the extractor voltage

§ To improve the accuracy of the set probe current values

Parts and Tools Designation Part no.

Faraday cup 348342-8055-000

Prerequisite ü The microscope has a Gemini II column

1. Load the Faraday cup into the specimen chamber.
2. Pump the specimen chamber.
3. Switch on the electron beam.
4. Set a magnification that allows transmission of the complete electron beam into the cavity

of the Faraday cup through the aperture orifice.
5. In the Panel Configuration Bar, double-click Probe Current Calibration.

à The Probe Current Calibration window is displayed.
6. Activate the Spot checkbox.
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7. Click Cal I Probe.
8. To confirm, click Yes.
9. To store the calibration, click Save.
10. Deactivate the Spot checkbox.

8.5 Power Circuit

8.5.1 Checking the Position of the Circuit Breakers

Safety Information NOTICE

Risk of property damage: Persisting electrical problems
Tripped circuit breakers may be a hint for an electrical problem in the microscope.

4 If a circuit breaker keeps tripping, de-energize the microscope completely and contact your
ZEISS service representative for assistance.

No. Value Circuit

F1 10 A Power supply unit

F2 10 A PC, WDX, EDX, AUX 1–4

F3 10 A Airlock, pre-vacuum pump

F4 10 A Internal heaters

1. Check if one of the circuit breakers on the rear
side of the plinth is tripped.

2. If one of the circuit breakers is tripped, push it upwards.

104 Instruction Manual ZEISS Crossbeam 550L, Crossbeam 550 | en-US | Rev. 3 | 349500-8122-000



ZEISS 8 Troubleshooting | 8.6 Detectors

8.6 Detectors

8.6.1 Lubricating the Rod

The rod from the aSTEM and BSD4 detector mechanics needs to be lubricated once a year with
TEM oil 300.

Parts and Tools Designation Part no.

TEM oil 300 000000-0484-955

Isopropanol –

Lint-free cloth –

Lint-free gloves –

 CAUTION

Risk of injury: TEM oil 300
TEM oil 300 may be irritating to skin and eyes.

4 Avoid contact with skin.

4 Wear suitable gloves.

4 In case of contact with the eyes, rinse immediately with plenty of water and seek medical
advice.

4 After contact with the skin, wash immediately with plenty of water and soap.

 CAUTION

Risk of injury: Isopropanol
Isopropanol is highly flammable and irritating to the eyes.

Vapors may cause drowsiness and dizziness.

4 Wear suitable gloves.

4 Keep away from sources of ignition.

4 Do not smoke.

4 In case of contact with the eyes, rinse immediately with plenty of water and seek medical
advice.

4 Avoid contact with skin.

4 Do not breathe vapor.

NOTICE

Risk of property damage: Unsuitable lubricants
When using unsuitable lubricants, the vacuum system may be contaminated.

4 Only use TEM oil 300 for lubricating.

1. Retract the respective detector.
2. Clean the rod with isopropanol with a clean, lint-free cloth.
3. Spread some drops of TEM oil 300 across the rod.

Use a clean, lint-free cloth.
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8.7 Focused Ion Beam

8.7.1 Checking the Lifetime of the Ion Source

Purpose The ion source is a consumable that is used up during operation.

In order to keep track of the ion supply, the ion source lifetime needs to be checked regularly.

Info
When the lifetime of the ion source approaches 3000 μAh, contact the ZEISS service represen-
tative to have the ion source replaced.

1. In the FIB Toolbar, from the FIB drop-down list, select FIB.
à The FIB tab of the FIB Control Panel is displayed.
à The lifetime of the ion source is indicated as μAh.

2. Check the lifetime of the ion source.

8.7.2 Regenerating the Ion Source by Heating

Purpose From time to time, the gallium emitter has to be regenerated by heating.

The heating procedure is used in following cases:

§ If the suppressor voltage has reached its limits (i.e. 0 V or 2 kV) while a probe current of 2 μA
cannot be maintained anymore

§ If the ion source does not start emitting

§ If the source is switched into Standby mode because the emission current exceeds the thresh-
old defined in the SmartSEM Administrator in the Go to Standby if emission exceeds input
field.

Info
Source heating can also be performed via Source Management. Source Management includes
automatically triggered procedures to ensure an optimum performance of the ion source.
These procedures are configured in the SmartSEM Administrator via FIB > FIB Source Manage-
ment.

Safety Information NOTICE

Risk of property damage: Ion source
Danger of damaging the ion source due to overheating. Excessive filament heating may reduce
source life.

4 Only heat as often as necessary.

Prerequisite ü Requires the Supervisor privilege.

1. In the Panel Configuration Bar, double-click FIB Ga Source Heating.
à The FIB Ga Source Heating window is displayed.

2. Click Multi-Heat.
à An automatic heating routine is performed.

3. If the ion source still does not start emitting, find a new extractor value.
Refer to Manually Finding a New Extractor Value [} 107].
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8.7.3 Manually Finding a New Extractor Value

Purpose If emission still fails after performing the multi-heating routine (see Regenerating the Ion Source
by Heating [} 106]), you have to find a new extractor value.

In a first step, you can use the automatic FIB extractor adjustment functions:

§ You can use Source Management. Source Management includes automatically triggered pro-
cedures to ensure an optimum performance of the ion source. These procedures are config-
ured in the SmartSEM Administrator via FIB > FIB Source Management.

§ You can trigger the extractor adjustment via FIB Control Panel > FIB > Extr. Adjust.

If the automatic FIB extractor adjustment functions fail, you have to find a new extractor value
manually.

1. In the FIB Toolbar, from the FIB drop-down list, select FIB.
à The FIB tab of the FIB Control Panel is displayed.

2. Click Standby.
à The FIB gun is set to Standby mode.

3. To disable the suppressor regulation, deactivate the Regulate checkbox.
4. Set the FIB Suppressor Target to 1200 V.
5. Select the Options tab.
6. Activate the FIB Extractor Manual Override checkbox.
7. Move the slider FIB Manual Extractor Target slowly until FIB emission starts.
8. Adjust the FIB Manual Extractor Target until emission is approximately 2 μA.
9. Leave the source in this condition for about 5 minutes, adjust the extractor voltage if neces-

sary to keep the emission at 2 μA.
10. Click Save Value.
11. Deactivate the FIB Extractor Manual Override checkbox.
12. Select the FIB tab.
13. To enable the suppressor regulation, activate the Regulate checkbox.

Info
During the process of finding a new extractor target, the FIB gun will be automatically
switched to the On state.
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9 Shutdown and Disposal

9.1 Putting the Microscope out of Operation

If the microscope will not be used for an extended period of time, e.g. several months, it should
be put out of operation.

Contact your local ZEISS service representative to have the microscope put out of operation.

9.2 Transport and Storage

 WARNING

Risk of injury: Tilting hazard when removing the microscope from the crate
When removing the microscope from the wooden crate, it can tilt and crush a person.

4 Use a forklift to remove the microscope from the wooden crate.

 CAUTION

Risk of injury: Crushing hazard when lowering the microscope
The microscope and its components are heavy. When the load is lowered during transport and
positioning, body parts can be crushed.

4 Maintain a safe distance.

4 Do not walk or place your hands or feet under the load while it is being lowered.

4 Wear safety shoes and gloves.

 CAUTION

Risk of injury or property damage: GIS precursors
If a gas injection system (GIS) is used, the precursors may be explosive, reactive, toxic or irritant
when they come into contact with the environment or a person.

4 Do not remove or install a GIS reservoir. Contact your local ZEISS service representative to
have a reservoir removed or installed.

4 The microscope may only be shipped if all precursors have been removed.

4 Precursors have to be shipped separately in a special transport container. For shipment al-
ways enclose a print-out of the respective material safety data sheet (MSDS).

4 Store and transport precursors only within the prescribed temperature ranges.

4 For further information, refer to the GIS instruction manual.
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NOTICE

Risk of property damage: Damage during transport
Sensitive components of the microscope can get damaged during transport.

4 The microscope may only be transported in air-suspended vehicles.

4 Moving parts must be secured during transport to prevent them from slipping or tipping
over.

4 Install shock/tilt watches.

4 Avoid rocking the crates back and forth.

4 Devices for transporting the microscope must be rated to handle its full weight and dimen-
sions. Note the weight information on the package and on the shipping document.

4 Check that none of the items has been damaged during shipment.

4 Otherwise contact your local ZEISS service representative.

Packaging of the Microscope

The microscope is delivered in two wooden crates:

§ Microscope plinth

Wrapped with recyclable polyethylene-foil and shipped in a reusable wooden crate.

Dimensions and weight of crate:

1550 × 1550 × 2200 mm³ (W × D × H), appr. 1300 kg

§ Microscope console and accessories

Console, valve, damper, monitors, cables, pipes etc. are wrapped with recyclable polyethyl-
ene-foil or packed in separate cartons and shipped in a reusable wooden crate.

Dimensions and weight of crate:

1720 × 1100 × 980 mm³ (W × D × H), appr. 300 kg

Guidelines for Unpacking the Microscope

Due to the heavy weight of microscopes, a forklift has to be used to remove the microscopes
from the wooden crate:

§ The forklift used must have a sufficient load capacity.

§ Refer to the weights of the microscope stated in this chapter.

Guidelines for Transporting the Unpacked Microscope

A hand pallet truck has to be used to move the microscope:

§ Ensure all hallways and corners are wide enough to be passed with the hand pallet truck.
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Allowable Conditions during Storage and Transport

The packed microscope has to be stored in a dry place.

Allowable temperature during storage and transport:

Microscope: between −10 °C and +70 °C

If a GIS system is part of the microscope, the GIS precursors have to be transported and stored
within the prescribed temperature ranges.

Allowable temperature during storage and transport:

Precursor: Gold −30 °C (at least < 8 °C)

Platinum < 5 °C

XeF₂ < 5 °C

All other reservoirs are allowed to be stored and transported
without cooling. However, ZEISS recommends to cool all
reservoirs during transport.

9.3 Disposal

9.3.1 Disposing of Solid Waste (Consumables)

The operator must ensure that solid waste (consumables) is disposed of and recycled in a respon-
sible manner.

Description Material Disposal

Schottky field emitter Tungsten, ceramics Used up emitters may be re-
turned to the emitter manu-
facturer.

Apertures Platinum, iridium, gold Very small amounts. May be
disposed of in accordance
with local/regional regula-
tions.

Ion source (gallium) Gallium To be returned to ZEISS.

GIS Precursors For information regarding the disposal of precursors, refer to
the instruction manual of the GIS.

9.3.2 Disposing of the Microscope

The operator must ensure that waste products are disposed of and recycled in a responsible man-
ner.

Refer to EC directive 2012/19/EC on waste electrical and electronic equipment (WEEE).

The microscope consists of several modules. Be careful to separate the materials properly when
you dispose of the microscope.

§ Materials: e.g. metals, non-metals, composite materials, process materials

§ Electronic scrap material: e.g. transformers, circuit boards, cables

Comply with national and regional waste disposal regulations.
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10 Technical Data and Conformity

10.1 Product Specification

Electron Optics

Parameter Description

Resolution GEMINI II column in High Resolution configuration (max. probe cur-
rent 40 nA)

Optimum working distance

Without using Tandem Decel:

§ 0.9 nm at 15 kV

§ 1.6 nm at 1 kV

Including Tandem Decel option:

§ 1.4 nm at 1 kV

GEMINI II column in High Current configuration (max. probe current
100 nA)

Optimum working distance

Without using Tandem Decel:

§ 0.9 nm at 15 kV

§ 1.8 nm at 1 kV

Including Tandem Decel option:

§ 1.6 nm at 1 kV

Acceleration volt-
age

Range: 20 V to 30 kV

Adjustment: Continuously variable in 10 Volt steps

Probe current High Resolution configuration: 10 pA to 40 nA

High Current configuration: 10 pA to 100 nA

Probe current regulation via a double condenser system

Magnification Range: 12x to 2,000,000x referenced to Polaroid image format

Electron source Filament: Schottky field emitter

Automatic emitter run-up: Safe controlled run-up to the target
emitter conditions

Objective lens Type: Patented GEMINI II electromagnetic/electrostatic objective lens
system (68º conical final lens) with water cooling for best thermal sta-
bility and reproducibility

Focus Working distance: Range from 1 to 50 mm, depending on accelera-
tion voltage

Focus compensation: Automatic compensation to minimize focus
changes over the entire acceleration voltage and probe current range

Dynamic focus: For correction of focus on tilted specimens

Focus wobble: For assistance in aperture alignment, with adjustable
amplitude and speed
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Parameter Description

Rotation compensation: Automatic correction of apparent image
rotation with changes in working distance

Beam shift For precise adjustment of image position at high magnifications

Width: 200 µm (±100 µm) at 20 kV and WD = 8.5 mm

Tandem decel (op-
tional)

Tandem decel module to apply negative bias to the specimen. Bias
voltage can be set to 1 kV, 2 kV, 3 kV, 5 kV and continuously varied
between 50 V and 100 V in steps of 1 V.

Airlock enabled specimen holder designed to ensure optimum electri-
cal field geometry included

Bias wobble for assistance with precise tilt alignment of specimen

Focused Ion Beam Column

Parameter Description

Ion Source Type: UHV, with gallium liquid metal ion source (Ga-LMIS)

Source Life: 3000 hours at 1 µA of emission current

Isolation: Automatically controlled valve for source isolation

FIB resolution 3 nm at 30 kV

Probe current 1 pA to 100 nA

Magnification 300x to 500,000x

Acceleration Volt-
age

Range: 0.5 to 30 kV

Adjustment: Continuously variable in 10 Volt steps

Imaging/Pattern-
ing

Maximum field of view: 580 × 580 µm

User beam shift: ±15 µm

Dwell time Minimum dwell time: 25 ns

Maximum dwell time: 1 s

Lenses Type: Two electrostatic lenses

Specimen Chamber and Stage

Parameter Description

Crossbeam 550 Crossbeam 550 L

Specimen chamber
dimensions

§ 330 mm inner diameter

§ 270 mm height

§ 520 mm inner diameter

§ 307 mm height

Free accessory
ports

18 for EDS, EBSD, SIMS, manipu-
lators etc.

22 free ports for optional acces-
sories such as load lock, STEM,
4QBSD, GIS, EDS, WDS, EBSD,
CL, flood gun, cryo transfer,
SIMS, manipulator, etc.
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Parameter Description

Crossbeam 550 Crossbeam 550 L

Analytical working
distance

5 to 8.5 mm

Coincidence point 5 mm (SEM), 12 mm (FIB)

Column arrange-
ment

The angle between electron-optical and focused ion beam-column is
54°.

Specimen stage Type: 6-axes motorized super-eucentric, controlled via the SmartSEM
user interface, operated by a dual joystick control box

Mounting: Drawer-type door

Movements:

§ X/Y = 100 mm

§ Z = 50 mm

§ M = 13 mm

§ Tilt = −4° to 70°

§ Rotation = 360° continuous

§ X/Y = 153 mm

§ Z = 50 mm

§ M = 20 mm

§ Tilt = −15° to 70°

§ Rotation = 360° continuous

INFO: The movements may be reduced by specimen size, operating
conditions, and accessories attached.

Accessory ports: Two accessory ports on the stage door are pro-
vided

Specimen weight: Up to 0.5 kg

Specimen current monitor with integrated touch alarm (audible
touch alarm warning with on-screen message)

Specimen mounts: One carousel 9x specimen holder for 13 mm di-
ameter stubs included in base tool configuration; various specimen
holders available as option

Plasma cleaner
(optional)

Integrated plasma cleaner:

Chamber mounted plasma cleaner for removal of hydrocarbon con-
tamination from both specimen and chamber; integrated software
control for user defined cleaning cycles without user interaction after
starting the cleaning process

Detection System

Parameter Description

Detection system Detection system equipped for parallel detection and signal process-
ing of multiple detector channels:

§ Up to 12 detector channels and up to 3 TV inputs

§ Parallel detection, processing, and display of up to four channels
possible

§ 2 signal detector inputs can be mixed for enhanced image infor-
mation

InLens detectors InLens SE detector:
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Parameter Description

High efficiency annular scintillator detector mounted in GEMINI col-
umn with optically coupled photomultiplier.

InLens EsB detector (optional):

Column-mounted high efficiency scintillator detector with optically
coupled photomultiplier for detection of energy and angle selective
backscattered electrons. Filtering grid adjustable from 0 V to −1.5 kV
for contrast adjustment.

Chamber detectors SE detector:

Everhart-Thornley SE detector with optically coupled photomultiplier;
collector bias adjustable from −250 to +400 V

SESI detector (optional):

Combined Secondary Electron Secondary Ion (SESI) detector based on
a scintillator photomultiplier system; easy change between secondary
ion and secondary electron mode by converting the electrode voltage;
replaces the SE detector

CL detector (optional):

Cathodoluminiscence (CL) chamber detector

aSTEM detector (optional):

Pneumatically retractable multi-mode annular Scanning Transmission
Electron Microscopy (aSTEM) detector; enables bright field (BF), dark
field (DF), and high angle annular dark field (HAADF) detection

aBSD/BSD detector (optional):

Pneumatically retractable 5 or 6 segment multi-mode solid state BSE
detector; enables materials contrast, crystal orientation, and topo-
graphic imaging

Chamber camera Color CCD camera with white-light illumination and IR illumination

Specimen current
monitor

6 range auto ranging for precise current measurement in the range of
1 pA to 10 µA

For more details, refer to the document Product Specification.

10.2 Installation Requirements

For a complete list of the installation requirements, refer to the document Installation Require-
ments.

Location Requirements

Parameter Requirement

Installation site Exclusively inside buildings

Recommended
room size

Min. 4.0 m × 5.0 m × 2.3 m

Service area Min. 1.0 m at each side

Entrance Min. 1.1 m wide

Hallways Min. 1.3 m wide
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Parameter Requirement

Corners Min. 1.5 m wide

Transport ways Free of staircases

Installation cate-
gory

II

Floor stability > 1000 kg/m2

Parameter Requirement

Installation site Exclusively inside buildings

Recommended
room size

Min. 3.5 m × 5.0 m × 2.3 m

Service area Min. 1.0 m at each side

Entrance Min. 0.8 m wide

Hallways Min. 1.0 m wide

Corners Min. 1.2 m wide

Transport ways Free of staircases

Installation cate-
gory

II

Floor stability > 1000 kg/m2

Parameter Requirement

Installation site Exclusively inside buildings

Recommended
room size

Min. 3.6 m × 5.0 m × 2.3 m

Service area Min. 0.8 m at each side

Entrance Min. 0.8 m wide

Hallways Min. 1.0 m wide

Corners Min. 1.2 m wide

Transport ways Free of staircases

Installation cate-
gory

II

Floor stability > 1000 kg/m2

Parameter Requirement

Installation site Exclusively inside buildings

Recommended
room size

Min. 3.6 m × 4.0 m × 2.3 m

Service area Min. 0.8 m at each side
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Parameter Requirement

Entrance Min. 0.8 m wide

Hallways Min. 1.0 m wide

Corners Min. 1.2 m wide

Transport ways Free of staircases

Installation cate-
gory

II

Floor stability > 1000 kg/m2

Exhaust Line

An exhaust line is required to remove the waste gas of the pre-vacuum pump and to transmit it to
the outside.

If toxic chemicals or biological specimens are used an exhaust line is recommended to remove the
waste gas of the pre-vacuum pump and to transmit it to the outside.

Electrical Supplies

Parameter Requirement

Nominal AC volt-
age

208–230 VAC (±10 %), L1/N(L2)/PE

The provided electrical connection must be in accordance with the ap-
plicable electrical codes for the country of installation. In order to
avoid disturbance from other installed machines, ZEISS recommends
using a separate power connection to the main distribution panel.

Protection class Class I

Nominal frequency 50–60 Hz

Momentary inter-
ruption

Less than a half cycle

System connection The microscope is delivered with a power cord 
3 × AWG10 UL-style (3 m long) and a CEE-connector (Type 32 A-6 h;
200 to 230 V, 2P+PE). Alternatively the microscope can be installed
directly to a switchable power distribution terminal which can be se-
cured against accidental re-activation.

Power consump-
tion

Max. 3.7 kVA, dependent on accessories

Maximum current 16 A

Circuit breaker (at
house installation)

25 A (type K)

Ampere interrupt-
ing capacity (AIC)

Min. 10,000 A rms

Protective ground High leakage currents are present in the microscope. Therefore, the
microscope has to be connected to an equipotential bonding bar. An
exclusive grounding connection to earth must be provided, i.e. the
grounding terminal must not be common to other electrical equip-
ment. A grounding wire AWG10 is delivered with the microscope.

Cross section: > 4 mm2

116 Instruction Manual ZEISS Crossbeam 550L, Crossbeam 550 | en-US | Rev. 3 | 349500-8122-000



ZEISS 10 Technical Data and Conformity | 10.2 Installation Requirements

Parameter Requirement

Ground resistance: < 0.1 Ω

Parameter Requirement

Nominal AC volt-
age

230 VAC 1/N/PE or

208 VAC 2/PE

The provided electrical connection must be in accordance with the ap-
plicable electrical codes for the country of installation. In order to
avoid disturbance from other installed machines, ZEISS recommends
using a separate power connection to the main distribution panel.

Protection class Class I

Nominal frequency 50–60 Hz

Momentary inter-
ruption

Less than a half cycle

System connection The microscope is delivered with a 3 m long power cord that is
equipped with a 200–250 VAC CEE MALE PLUG 2P3W 6h 16A (blue)
according to IEC 60309.

The supplied connection cable must not be replaced with another
one. Otherwise, the conformity with listed standards becomes invalid.

The building installation should provide the corresponding 200–250
VAC CEE FEMALE RECEPTACLE 2P3W 6h 16A (blue) with the correct
wiring 1/N/PE or 2/PE and the desired approvals of the country used.

To avoid disturbance from other installed machines Carl Zeiss Mi-
croscopy recommends to use a separate power connection to the
main distribution panel.

Power consump-
tion

Max. 3 kVA, dependent on accessories

Circuit breaker (at
house installation)

16 A Type C

Ampere interrupt-
ing capacity (AIC)

Min. 10,000 A rms

Protective ground High leakage currents are present in the microscope. Therefore, the
microscope has to be connected to a separate protective ground.

An exclusive grounding connection to earth must be provided as part
of the building installation, i.e. a grounding screw terminal (Ø 8 mm)
which is directly connected to the PE of the FEMALE RECEPTACLE as
short as possible. (see picture)

This grounding connection must not be common to other electrical
equipment.
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Parameter Requirement

A grounding wire AWG10 (≥ 5 m) is delivered with the microscope. It
serves as connection between the grounding screw terminal (Ø 8 mm)
and the microscope (Ø 6 mm).

Cross section: Min. AWG10 (between grounding screw terminal and
PE of the CEE FEMALE RECEPTACLE)2

Parameter Requirement

Nominal AC volt-
age

120 VAC (single phase) or 230 VAC (single phase)

The provided electrical connection must be in accordance with the ap-
plicable electrical codes for the country of installation. In order to
avoid disturbance from other installed machines, ZEISS recommends
using a separate power connection to the main distribution panel.

Details see System Connection

Protection class Class I

Nominal frequency 50–60 Hz

Momentary inter-
ruption

Less than a half cycle

System connection The microscope is delivered with a power cord 3 m long equipped
with a CEE plug 1/N/PE according to IEC 60309 depending on the cus-
tomers site supply: either for 120 VAC a CEE MALE PLUG 2P3W 4h 20A
(yellow) or for 230 VAC a CEE MALE PLUG 2P3W 6h 16A (blue).

The building installation should provide the corresponding CEE socket
1/N/PE with desired approvals of the country used: either for 120 VAC

a CEE FEMALE RECEPTACLE 2P3W 4h 20A (yellow) or for 230 VAC a
CEE FEMALE RECEPTACLE 2P3W 6h 16A (blue).

To avoid disturbance from other installed machines Carl Zeiss Mi-
croscopy recommends to use a separate power connection to the
main distribution panel.

Power consump-
tion

Max. 3 kVA, dependent on accessories

Circuit breaker (at
house installation)

16 A Type C

Ampere interrupt-
ing capacity (AIC)

Min. 10,000 A rms
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Parameter Requirement

Protective ground High leakage currents are present in the microscope. Therefore, the
microscope has to be connected to a separate protective ground.

An exclusive grounding connection to earth must be provided as part
of the building installation, i.e. a grounding screw terminal (Ø 8 mm)
which is directly connected to the PE of the FEMALE RECEPTACLE as
short as possible.

This grounding connection must not be common to other electrical
equipment.

A grounding wire AWG10 (≥ 5 m) is delivered with the microscope. It
serves as connection between the grounding screw terminal (Ø 8 mm)
and the microscope (Ø 6 mm).

Cross section: Min. AWG10 (between grounding screw terminal and
PE of the CEE FEMALE RECEPTACLE)2

Cooling Water

Major components of the microscope such as electron-optic lenses, parts of the electronics and
the turbo molecular pump are water-cooled. Any cooling solution has to fulfil the following re-
quirements.

Parameter Requirement

Water flow rate 60–70 l/h

Pressure Adjustable up to 3 bar

Water tempera-
ture

20–22 °C

Stability 0.5 °C/10 min

Heat dissipation 1 kW

Connection hose 6 mm inside diameter. Two pieces 10 m each are delivered.

Parameter Requirement

Water flow rate > 1.5 l/min

Pressure 2–3 bar

Water tempera-
ture

18–22 °C
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Parameter Requirement

Stability 0.5 °C/10 min

Heat dissipation 1 kW

Connection hose 8 mm inside diameter. One 25 m roll is delivered with the microscope.

Instrument con-
nection

Quick exchange connectors. Two are delivered with the microscope.

Nitrogen

Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. The nitro-
gen can be taken either from a gas cylinder or from an in-house supply system.

The connection must be equipped with an appropriate pressure reducer and a shut-off valve that
is secured against accidental re-activation.

Parameter Requirement

Flow rate Approx. 40 l/min for ventilation of specimen chamber with chamber
door open

Pressure 0.30–0.35 MPa (3.0–3.5 bar)

Quality 4.6 with nitrogen content > 99.996 %

Connection hose 6 mm inside diameter. 10 m are delivered with the microscope.

Parameter Requirement

Flow rate Approx. 3 l/min for ventilation of specimen chamber with chamber
door open

Pressure 0.2–3.3 bar

Quality 4.6 with nitrogen content > 99.996 %

Connection hose 4 mm inside diameter. 10 m are delivered with the microscope.

Instrument con-
nection

Quick exchange connector. One is delivered with the microscope.

Compressed Air

Compressed air is used to operate several valves and the auto leveling system.

The necessary compressed air can be either generated by a compressor (part no.
345596-0000-000) or taken from a gas cylinder or from an in-house supply system.

The connection must be equipped with an appropriate pressure reducer and a shut-off valve that
can be secured against accidental re-activation.

Parameter Requirement

Typical flow rate Approx. 12 l/min at 0.6 MPa pressure during air leveling system infla-
tion

Pressure 0.6–0.8 MPa (6–8 bar)

Quality Oil-free

Connection hose 6 mm inside diameter. 10 m are delivered with the microscope.
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Parameter Requirement

Typical flow rate Less than 1 l/min during normal operation

Pressure 0.6–0.8 MPa (6–8 bar)

Quality Oil-free

Connection hose 4 mm inside diameter. 10 m of pipe are delivered with the micro-
scope.

Instrument con-
nection

Quick exchange connector. One is delivered with the microscope.

INFO: Due to acoustic noise and vibrations the compressor – if used –
should be installed in a separate room.

Environmental Requirements

Parameter Requirement

Ambient tempera-
ture

Appr. 21±4 °C

Stability of ambi-
ent temperature

0.5 °C/h

For long-running
experiments:
Long-term stability
of ambient tem-
perature

2 °C/24 h

Relative humidity Less than 65 %

Altitude Max. 2000 m above sea level to guarantee an undisturbed operation

Pollution degree 2

Electrical field The microscope is a class A device (industrial). The microscope is de-
signed to operate in a controlled electromagnetic environment. This
means that devices with RF transmitters such as mobile phones or
DECT phones must not be used in close proximity.

Vibrations Up to 10 Hz: less than 5 μm/s

10–60 Hz: less than 10 μm/s

Above 60 Hz: less than 14 μm/s

Magnetic stray
fields

Measured in time domain and at specimen chamber height (1.0–
1.5 m).

DC component: 0.5 mG / 5 min or less

AC component: less than 1 mG peak to peak between 10 Hz and
1 kHz

Acoustic noise Up to 120 Hz: less than 52 dB

120–450 Hz: less than 43 dB

Above 450 Hz: less than 47 dB

Parameter Requirement

Ambient tempera-
ture

Appr. 21±4 °C
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Parameter Requirement

Stability of ambi-
ent temperature

0.5 °C/h

For long-running
experiments:
Long-term stability
of ambient tem-
perature

2 °C/24 h

Relative humidity Less than 65 %

Altitude Max. 2000 m above sea level to guarantee an undisturbed operation

Pollution degree 2

Electrical field The microscope is a class A device (industrial). The microscope is de-
signed to operate in a controlled electromagnetic environment. This
means that devices with RF transmitters such as mobile phones or
DECT phones must not be used in close proximity.

Vibrations Horizontal vibrations (in x/y-direction)

Up to 10 Hz: less than 5 μm/s

10–60 Hz: less than 10 μm/s

Above 60 Hz: less than 14 μm/s

Vertical vibrations (in z-direction)

Up to 10 Hz: less than 4 μm/s

10–60 Hz: less than 14 μm/s

Above 60 Hz: less than 20 μm/s

Magnetic stray
fields

Measured in time domain and at specimen chamber height (1.0–
1.5 m).

DC component: 0.5 mG / 5 min or less

AC component: less than 1 mG peak to peak between 10 Hz and
1 kHz

Acoustic noise Up to 120 Hz: less than 52 dB

120–450 Hz: less than 43 dB

Above 450 Hz: less than 47 dB

Parameter Requirement

Ambient tempera-
ture

Appr. 21±4 °C

Stability of ambi-
ent temperature

0.5 °C/h

For long-running
experiments:
Long-term stability
of ambient tem-
perature

2 °C/24 h

Relative humidity Less than 65 %

Altitude Max. 2000 m above sea level to guarantee an undisturbed operation
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Parameter Requirement

Pollution degree 2

Electrical field The microscope is a class A device (industrial). The microscope is de-
signed to operate in a controlled electromagnetic environment. This
means that devices with RF transmitters such as mobile phones or
DECT phones must not be used in close proximity.

Vibrations Horizontal vibrations (in x/y-direction)

Up to 10 Hz: less than 0.04 mm/s

10–20 Hz: less than 0.17 mm/s

20–70 Hz: less than 0.30 mm/s

Above 70 Hz: less than 20 mm/s

Vertical vibrations (in z-direction)

Up to 8 Hz: less than 0.03 mm/s

8–45 Hz: less than 0.15 mm/s

Above 45 Hz: less than 2.00 mm/s

Magnetic stray
fields

Less than 3 mG peak to peak between 10 Hz and 1 kHz (Sigma 300)

Less than 1 mG peak to peak between 10 Hz and 1 kHz (Sigma 500)

Acoustic noise Sigma 300:

Less than 53 dB for frequencies up to 200 Hz

Less than 42 dB for frequencies from 200 up to 300 Hz

Less than 50 dB for frequencies higher than 300 Hz

Sigma 500:

Less than 50 dB for frequencies up to 200 Hz

Less than 40 dB for frequencies from 200 up to 400 Hz

Less than 45 dB for frequencies higher than 400 Hz

Parameter Requirement

Ambient tempera-
ture

20-30 °C

It is recommended that for operator comfort the room temperature is
maintained between 22 °C and 24 °C.

Stability of ambi-
ent temperature

0.5 °C/h

For long-running
experiments:
Long-term stability
of ambient tem-
perature

2 °C/24 h

Relative humidity Less than 65 %

Altitude Max. 2000 m above sea level to guarantee an undisturbed operation

Pollution degree 2

Electrical field The microscope is a class A device (industrial). The microscope is de-
signed to operate in a controlled electromagnetic environment. This
means that devices with RF transmitters such as mobile phones or
DECT phones must not be used in close proximity.
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Parameter Requirement

Vibrations Less than 6 μm/sec rms from 0–30 Hz

Less than 12 μm/sec rms above 30 Hz

Magnetic stray
fields

Max. 3 × 10⁻⁷ T (peak to peak) = 3 mG (peak to peak)

Acoustic noise Less than 53 dB for frequencies up to 200 Hz

Less than 42 dB for frequencies from 200 up to 300 Hz

Less than 50 dB for frequencies higher than 300 Hz

10.2.1 Layout and Connections

A

B

C D
E

F

G

H

I

1 2

3

4

1   Static vibration damper A Mains power supply
208...230 V/25 A, L1/N(L2)/PE

2   Pre-vacuum pump Equipotential bonding bar

3   Computer workplace Pressure reducer (water, nitrogen,
compressed air)

4   Emergency Off (EMO) button (optional) Main shut-off valves

Water supply

Water runback

Nitrogen supply

Compressed air supply

Exhaust line
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A

B

C D
E

F

G

H

I

1 2

3

4

1   Static vibration damper A Mains power supply 208...230 V,
max. 16 A

2   Pre-vacuum pump Equipotential bonding bar, afety
earth

3   Plinth and column Vacuum exhaust

4    Computer workplace Chilled water supply

Dry compressed air

Dry nitrogen supply
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A

B

C D
E

F

G

H

I

1 2

3

4

1   Static vibration damper A Mains power supply

120 V, 50–60 Hz, 16 A, 1/N/PE or

230 V, 50–60 Hz, 16 A, 1/N/PE

2   Pre-vacuum pump Equipotential bonding bar /
grounding screw terminal (Ø 8 mm)

3   Pre-vacuum pump 2 (optional) Pressure reducer (nitrogen)

4   Computer workplace Main shut-off valve

5   Emergency Off (EMO) box (optional) Nitrogen supply

6   Emergency Off (EMO) button (optional) Exhaust line (optional)
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10.2.2 System Layout

4

ca
. 

1
8

0
0

 (
C

ro
ss

b
ea

m
 5

5
0

) 
/ 

1
8

8
0

 (
C

ro
ss

b
ea

m
 5

5
0

 L
)

ca
. 

1
5

7
8

765

330 (1440)

8
3

8

1

2

3
4

5 51 1 4

2

5

Fig. 37: System layout

1 Plinth + column + Ion-sculptor FIB (+ 200 mm airlock)

2 Table + PC

3 Static damping block

4 Pre-vacuum pump

5 FIB rack

Description Size (mm) appr. Distribution of
load (kg)

Footprints

Plinth + column + Ion-sculptor FIB 940 × 1070 × 1800 4 × 250 4 × Ø 80 mm

Plinth + column + Ion-sculptor FIB
+ 200 mm airlock

1080 × 1070 × 1800 4 × 260 4 × Ø 80 mm

Table + PC 1650 × 1000 × 838

or

1100 × 1000 × 838

4 × 24.3 4 × Ø 50 mm
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Description Size (mm) appr. Distribution of
load (kg)

Footprints

Static damping block 180 × 180 × 160 1 × 12.0 180 mm × 180 mm

Pre-vacuum pump 432 × 265 × 295 1 × 24.5 200 mm × 180 mm

FIB rack 560 × 810 × 1600 4 × 50 on wheels

Chiller (optional, water- or air-cooled)* 530 × 640 × 740 4 × 22.5 on wheels

Compressor* 281 × 139 × 239 1 × 25.0 281 mm × 139 mm

*Actual measurements are country dependent (different manufacturers).

Description Size (mm) appr. Distribution of
load (kg)

Footprints

Plinth + column + Ion-sculptor FIB 940 × 1070 × 1800
(Crossbeam 550)

940 × 1070 × 1880
(Crossbeam 550 L)

4 × 250

4 × 297.5

4 × Ø 80 mm

Plinth + column + Ion-sculptor FIB
+ 200 mm airlock

1080 × 1070 × 1800
(Crossbeam 550)

1080 × 1070 × 1880
(Crossbeam 550 L)

4 × 260

4 × 305

4 × Ø 80 mm

Table + PC 1650 × 1000 × 838

or

1100 × 1000 × 838

4 × 24.3 4 × Ø 50 mm

Static damping block 180 × 180 × 160 1 × 12.0 180 mm × 180 mm

Pre-vacuum pump 432 × 265 × 295 1 × 24.5 200 mm × 180 mm

FIB rack 560 × 810 × 1600 4 × 50 on wheels

Chiller (optional, water- or air-cooled)* 530 × 640 × 740 4 × 22.5 on wheels

Compressor* 281 × 139 × 239 1 × 25.0 281 mm × 139 mm

*Actual measurements are country dependent (different manufacturers).
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10.3 Declaration of Conformity

Denomination Focused Ion Beam - Scanning Electron Microscope (FIB-SEM)

Model Crossbeam 550/550L

Manufacturer Carl Zeiss Microscopy GmbH
Carl-Zeiss-Str. 22
73447 Oberkochen
Germany

We declare under our sole responsibility that the above machinery and the optional accessories
fulfil all the relevant provisions of the following EC Directives:

§ 2006/42/EC – Machinery Directive

§ 2014/30/EU – Electromagnetic Compatibility

Applied harmonized standards:

§ EN ISO 12100:2010 – Safety of machinery – General principles for design – Risk assessment
and risk reduction

§ EN ISO 13849-1:2008 – Safety of machinery – Safety related parts of control systems –
Part 1: General principles for design

§ EN 60204-1:2006 – Safety of machinery – Electrical equipment of machines – Part 1: Gen-
eral requirements

§ EN 61010-1:2010 – Safety requirements for electrical equipment for measurement, control,
and laboratory use

§ EN 61326-1:2013 – Electrical equipment for measurement, control and laboratory use –
EMC requirements – Part 1: General requirements

CE Marking The CE conformity marking is located on the type plate of the machinery or the optional acces-
sory, respectively.

Unauthorized modifications of the machinery or the optional accessory will cancel this declara-
tion.
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11 Parts and Tools

NOTICE

Risk of property damage: Spare parts and consumables
Using spare parts or consumables that are not provided by ZEISS can lead to property damage.

4 Only genuine spare parts and consumables supplied by ZEISS are to be used in servicing
the microscope.

4 Contact your ZEISS service representative for information regarding how to order spare
parts and consumables.

4 Unless otherwise authorized by ZEISS, all spare parts and consumables must be installed by
a ZEISS service representative.

11.1 Consumables

Required Parts/Tools Part Number

Schottky field emitter (gun) by DENKA 000000-0302-460

Aperture (single hole), 35 μm thin film 348520-0229-000

Anode aperture, 55 μm (40 nA High Resolu-
tion configuration)

348520-0621-000

Anode aperture, 90 μm (100 nA High Current
configuration)

348520-0580-001

Extractor aperture 348520-0097-001

Anode aluminum seal 348520-0266-001

Copper seal gun head (single use) 000000-0546-290

Tip seal for pre-vacuum pump BOC Edwards
XDS 10

000000-0113-989

Scintillator for SE detector 348306-8142-000

Ion source (gallium) 360100-0000-540

With GIS upgrade: Precursors On request

11.2 Spare Parts

Required Parts/Tools Part Number

Chamber door O-ring 000000-0476-960

11.3 Tools and Accessories

Required Parts/Tools Part Number

Faraday cup 348342-8055-000

3 mm Allen key 000000-0015-247
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Required Parts/Tools Part Number

1.5 mm Allen key 000000-0151-883

Small pliers –

Specimen holders Refer to specimen holder catalog.

Stubs –

Tweezers –

Lint-free cloth –

Lint-free gloves –
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Index

A
aBSD detector  47, 86
Accessory  131
Adjusting

Probe current  80
Analytic gun mode  79
Aperture  94
aSTEM detector  50, 88, 105

B
Backscattered electron  37
Bakeout  102
Baking out the gun head  102
Beam mode  33
BSD detector  46, 86
BSD4 detector  105

C
CAN communication  99
Cathodoluminescence  37, 52
CCD camera  40
Chamber CCD camera  40
Chamber door seal  101
Chamberscope  40
Checking

CAN communication  99
Lifetime of the ion source  106
Position of the circuit breaker  104
Temperature  102

Chemicals  94
CL detector  52, 91
Column mode  82
Consumable  130
Consumable and chemical  94
Consumables  94
Control panel  53
Cover panel, protective  18

D
Declaration of conformity  129
Detector  38, 82

aBSD  47, 86
aSTEM  50, 88, 105
BSD  46, 86
BSD4  105
CL  52, 91
EsB  45, 84
Everhart-Thornley  40
InLens SE  39, 83
SE  40, 83
SESI  44, 85
STEM  88

Detector mechanics
Lubricating the rod  105

Detector settings  83
Disposal  108

Microscope  110
Solid waste  110

Dual joystick  43

E
Electron optical column  31
Emergency off (EMO) option  19
Emergency shutdown  93
Emitter life  94
EsB detector  45, 84
Everhart-Thornley detector  40
Extractor voltage  81

F
Faraday cup  80
FIB column  35
Focus wobble  76
Fuse  104

G
Gemini II column  31
GUI  55
Gun head, bakeout  102
Gun mode

Analytic  79
Imaging  79
Normal  79

H
Hazard  15

Biological hazard  15
Burn hazard  15
Chemical hazard  15
Electrical hazard  16
High pressure hazard  16
Magnetic field hazard  16
Mechanical hazard  16
Radiation hazard  17
Suffocation hazard  17

I
Image

Acquisition  68, 74
Optimization  76
Saving  78

Imaging
Imaging mode  36

Imaging gun mode  79
Initializing the stage  99
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InLens SE detector  39, 83
Installation  64
Intended use  13
Ion source

Checking the lifetime  106
Regenerating  106

Ion-sculptor focused ion beam (FIB) column
 35

J
Joystick TV angle  100

K
Keyboard Shortcut  66

L
License

REDUCED  77
Locking device  20
Lockout/tagout  93
Lockout/tagout equipment  21
LOTO  21, 93

M
Main Switch  19
Maintenance

Consumable and chemical  94
Interval  94
Procedure  94

Microscope
Disposal  110
Shutdown  108
Switching on  65, 66

N
Normal gun mode  79

O
Online help  66
Operator

Advanced  14
Basic  14
Training  14

Optimizing the image  76

P
Prevention of hazards  15
Preventive maintenance  14
Primary electron  37

Probe current  80
Calibration  103

Q
Quiet Mode  30

R
Regenerating the ion source  106
Related documents  11
Replacing the chamber door seal  101
Requirements for personnel  14
Resetting the touch alarm  101

S
Safe operation condition  14
Safety  13

Safety equipment  18
Safety label  22
Safety procedure  14

Saving images  78
Scintillator  94
SE detector  40, 83
Secondary electron  37
Secondary electrons secondary ions detector

 44
Service  14
SESI detector  44, 85
Setting the probe current  80
Shortcuts  66
Shutdown

Emergency  93
Finishing the work session  91
Microscope  108

Signal detection  37
SmartFIB Program Suite  63
SmartFIB User Interface  61
SmartSEM

User interface  55
SmartSEM program suite  59
SmartSEM user interface  55
Software  55
Software manual  11
Solid waste, disposal  110
Spare part  15, 130
Special Keys  66
Specimen current  80
Stage

Post initialization position  100
Stage control  43
Stage initialization  99
Starting SmartSEM  66
Starting the microscope  66
STEM detector  88
Supervisor privilege  106
Switching off

Gun  102
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Switching on
EHT  74
Gun  73
Microscope  65, 66

T
Temperature  102
Tool  131
Touch alarm, reset  101
Transmitted electron  37
Troubleshooting  96
Type plate  25, 26

U
User access level  57
User interface  55
User privilege  57

V
Vacuum system  29
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Carl Zeiss Microscopy GmbH
Carl-Zeiss-Promenade 10
07745 Jena
Germany

phone: +49 1803 33 63 34
fax: +49 3641 64 3439

info.microscopy.de@zeiss.com
www.zeiss.com/microscopy
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